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Read Me First 
Welcome to Take Control of Upgrading to High Sierra, version 1.1.2, 
published in October 2017 by alt concepts inc. This book was written 
by Joe Kissell and edited by Tonya Engst. 

Upgrading your Mac to a new operating system can be a daunting 
prospect, but with some expert advice, you’ll be running macOS 10.13 
High Sierra in no time. This book eliminates the uncertainty and the 
confusion, guiding you through every step of the process. 

If you want to share this ebook with a friend, we ask that you do so 
as you would with a physical book: “lend” it for a quick look, but ask 
your friend to buy a copy for careful reading or reference. 

Copyright © 2017, alt concepts inc. All rights reserved. 

Updates and More
 

You can access extras related to this ebook on the web (use the link 
in Ebook Extras, near the end; it’s available only to purchasers). On 
the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy 
any subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

•	 Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

If you bought this ebook from the Take Control website, it has been 
added to your account, where you can download it in other formats 
and access any future updates. However, if you bought this ebook 
elsewhere, you can add it to your account manually; see Ebook Extras. 
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Basics
 

To review background information that might help you understand 
this book better, such as finding System Preferences and working with 
files in the Finder, read Tonya Engst’s free ebook Read Me First: A 
Take Control Crash Course, available on the web or as a standalone 
ebook in PDF, EPUB, and the Kindle’s Mobipocket format. 

What’s New in Version 1.1.2
 

Version 1.1.2 fixes a couple of shortcomings in version 1.1.1. In Learn 
about APFS, I added a note about external SSDs, and clarified that 
Time Machine disks must not be formatted as APFS, regardless of the 
format your startup volume uses. I also corrected erroneous informa-
tion about content caching found in previous versions of this book, and 
added instructions for using a High Sierra Mac as a Time Machine 
server; for both topics, see System Preferences Changes. 

Version 1.1.1 was a minor “bug fix” update that corrected the minimum 
system requirements for installing High Sierra from 10.7.5 Lion to 
10.8 Mountain Lion, mentioned a couple of missing features in Find 
Out What’s New in High Sierra, slightly updated the details in 
Firmware Updates and Free Disk Space, and added a brief note in 
Obtain the Installer about automatic downloads. 

And version 1.1 updated the book to cover the official 10.13.0 release 
version of High Sierra. Among other changes, that version added a 
largely rewritten Learn about APFS topic, a sidebar called About 
Microsoft Office and High Sierra, and updated information in System 
Preferences Changes. 
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Introduction 
In the summer of 2017, my family and I took a road trip to some scenic 
California locations—mostly in and around the Sierra Nevada moun-
tain range, or as it’s known colloquially, the High Sierra. Our travels 
included a visit to Yosemite National Park, where of course we saw the 
massive El Capitan rock formation. We went to these places because 
they’re beautiful and relatively nearby, but the fact that they were also 
the namesakes of the last four versions of macOS was not lost on us. I’d 
like to think we found a bit of inspiration for working on our books 
about High Sierra, including this one. 

Several times over the years, Apple has released new versions of the 
Mac operating system that focused mainly on performance improve-
ments, bug fixes, and usability—with only modest changes in user-
facing features. (Think: Leopard to Snow Leopard, Lion to Mountain 
Lion, and Yosemite to El Capitan.) macOS 10.13 High Sierra is such an 
upgrade—it looks and acts almost like its predecessor 10.12 Sierra, but 
has a more robust infrastructure (plus a few interesting new features). 

Upgrading to High Sierra involves steps nearly identical to installing 
any of the past several versions of macOS. Apple has gone to great 
lengths to make it both easy and safe to keep your Mac up to date, and 
the installer is about as user-friendly as you can get. Most people will 
upgrade painlessly. 

And yet, here I am again—for the eleventh time!—with a book about 
how to upgrade your Mac. I keep writing these books because, despite 
Apple’s excellent efforts to make their installers bulletproof, things can 
and do go wrong. If anything surprises me during my many test instal-
lations of High Sierra (and indeed, a few things did!), I know that other 
people will encounter similar things and will want to know what to 
expect. 

Even when nothing goes wrong, you may face questions or decisions 
you don’t know how to handle. This book, like its predecessors, is 
intended to walk you through every step of the process, anticipate the 
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issues that may confuse or frustrate you, and make upgrading as 
smooth as possible. 

For example, one of the most important changes to High Sierra is the 
long-awaited switch to a new file system (Apple File System, or APFS— 
see Learn about APFS). In most cases, this change will be entirely 
invisible. Assuming your Mac supports APFS, you’ll notice that certain 
things happen more quickly in the Finder, but your Mac won’t look any 
different. And yet, this otherwise wonderful new feature has a number 
of maddening gotchas, so I show you what you’re getting yourself into 
before you make the leap. The advice in this book, which includes 
making thorough backups before you upgrade, will enable you to avoid 
or solve most of the problems you may encounter. 

I also explain why Apple’s minimum system requirements don’t tell 
the whole story about what you need to run High Sierra successfully, 
offer advice on avoiding software incompatibilities, show you how to 
recover disk space if you don’t have enough to upgrade your system, 
and explore several other issues that can complicate the process. 

If you’ve upgraded your Mac numerous times, keep excellent backups, 
have up-to-date hardware and software, and consider yourself techni-
cally proficient, then really…you don’t need this book. But if you count 
yourself among those feeling anxiety, confusion, or uncertainty about 
upgrading to High Sierra, you’ve come to the right place. 

As of the initial release of High Sierra 10.13.0, some promised features 
are either missing or not yet fully working. So I’ll be keeping an eye on 
future releases, and if major changes warrant it, I’ll update this book 
accordingly. For less urgent information, I’ll post a notice on the book’s 
blog. To check for an updated copy of this ebook (or any other impor-
tant information), click the link in Ebook Extras. 
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High Sierra Upgrade 
Quick Start 

I’ve arranged this book in logical order, and I recommend performing 
these steps in the order I present them. You need not learn every last 
detail, but I hope you’ll at least skim the whole thing. 

Start on the right foot: 
•	 Discover what you have to look forward to when you upgrade to 

High Sierra, as well as what features were added (and removed) in 
the last several upgrades. Read Catch Up with macOS Changes. 

•	 If you’re upgrading from the High Sierra beta, read the sidebar 
Upgrading from the High Sierra Beta. 

Prepare to upgrade: 
•	 Make sure your computer can run High Sierra. See Check Your Mac 

for Compatibility. 

•	 Back up before you go forward! See Back Up Your Disk. 

•	 Make sure key software is up to date, and remove clutter that could 
interfere with the upgrade. See Clean Up Your Mac. 

•	 Decide which overall upgrade strategy is best for you. See Decide on 
an Installation Method. 

Perform the upgrade: 
Follow the strategy you selected earlier to run the High Sierra installer, 
choosing all the optimal settings and options, and making sure all your 
personal data is still in place afterward. You’ll do one of the following: 

•	 Upgrade Using Plan A: In-place Upgrade 

•	 Upgrade Using Plan B: Clean Install 

7 



  
       
        

          

         
      

After the upgrade: 
•	 Perform Post-installation Tasks, such as responding to login 

requests, installing updates to macOS, and tweaking preferences. 
You’ll also deal with any surprises that may occur along the way. 

•	 Problems? If your computer isn’t working properly after the 
upgrade, don’t panic. See Troubleshoot Upgrade Problems. 

8 



           
          

               
         

           
           

          

      

           
              
    

        
        

     

       
     

       

        
      

          

          
            

        
  

           
           

   

Take In the Scenic View 
Since you’ve bought this book, I assume you’ve already decided to 
upgrade to High Sierra and don’t need convincing that it’s worth your 
time and effort. However, I would like to call attention to some of the 
biggest changes in High Sierra that you can look forward to. 

In addition, if you’re upgrading from an operating system older than 
macOS 10.12 Sierra, you may be interested to know what other features 
were added along the way—as well as some that were removed. 

Find Out What’s New in High Sierra
 

Apple has a list of new High Sierra features on this webpage. I won’t 
catalog them all here, but I’d like to list some of the most notable 
changes and improvements since Sierra: 

•	 Apple File System: Replacing the decades-old Mac OS Extended 
(or HFS Plus) file system, Apple File System improves security, 
performance, and reliability. See Learn about APFS. 

•	 Better video encoding: High Sierra supports a new video encod-
ing standard—HEVC, or High Efficiency Video Coding—which 
greatly reduces the storage space required for videos. 

•	 Metal 2: This significantly improved version of Apple’s graphics 
API (application programming interface) enables developers to 
squeeze more power out of your Mac’s graphics processor, or GPU. 

•	 Safari: Safari has new tools to block advertisers from tracking you, 
stop videos from autoplaying when you load a page, show articles in 
Safari Reader by default, and customize your browsing experience 
in other ways. 

•	 Siri: Siri now has a more human-sounding voice. It also gives you 
the option to type (rather than speak) your questions, and has more 
extensive integration with Apple Music. 

9 
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•	 Photos: The Photos app has improved organizational features, an 
expanded sidebar, new filters and editing tools, a looping effect for 
Live Photos, better integration with third-party apps, and more. 

Apple also removed a few minor features—ones I’ve noticed so far 
include the All My Files category in the Finder sidebar and the Shared 
Links feature (for keeping track of RSS feeds) in Safari. 

If you’re already running 10.12 Sierra, that’s all you need to know for 
now—skip ahead to Learn about APFS. But if your Mac is still using an 
older operating system, read on to learn about some changes in the 
past few releases that you may not be fully prepared for. 

Note: Microsoft Office users, pay special attention to the sidebar
 

About Microsoft Office and High Sierra, later, which discusses which
 

versions of Office may or may not work.
 

Catch Up with macOS Changes
 

The older the operating system you’re upgrading from, the more 
changes you’ll notice in High Sierra—and the greater the likelihood 
that you’ll encounter compatibility problems with old hardware and 
software. You’ll find great new features, but you may also have to 
abandon software you’ve used for many years, adopt new habits, or 
reorient your thinking about how a Mac works. Before you jump in, 
you should understand what awaits you. 

Read the topics below covering any operating systems you’ve never 
installed on your Mac. 

Changes in Sierra 
If you’re running OS X 10.11 El Capitan or earlier, here’s what you need 
to know about the changes in macOS 10.12 Sierra (apart from the fact 
that Apple rebranded the operating system from “OS X” to “macOS”). 

Sierra finally brought Siri to the Mac. It also added Apple Pay (in 
Safari); Auto Unlock with Apple Watch; Universal Clipboard (so you 
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can copy something on one of your Apple devices and paste it on 
another); iCloud Drive sync for your Desktop and Documents folders; 
optimized storage (the option to delete local copies of files stored in 
iCloud Drive if you run low on disk space); tabs in almost every app; a 
picture-in-picture view for videos; and various improvements to 
Photos, Messages, Mail, and iTunes. 

Unfortunately, fax and modem support was largely discontinued 
starting in Sierra. If you previously used an Apple USB Modem with 
your Mac—either for dial-up internet access or to send and receive 
faxes—you should know that High Sierra no longer supports your 
modem. Some third-party USB modems and multifunction (printer, 
fax, scanner, copier) devices that include their own driver software 
may still work with High Sierra for both internet access and faxing, as 
long as the drivers support a 64-bit kernel. In particular, I’ve read 
(although I haven’t tested them myself) that the USRobotics USR5637 
and Zoom 3095 modems should be compatible, but I can’t guarantee 
it. 

If you need to send or receive faxes in High Sierra, there are a few 
alternatives (such as running a virtual machine, using an internet fax 
service, and copying the old drivers from El Capitan). Adam Engst lays 
out the options in his TidBITS article Lost in Sierra: Five Missing 
Features. 

Changes in El Capitan 
If you’re still using OS X 10.10 Yosemite or earlier, you’ll want to know 
what changed in 10.11 El Capitan. El Capitan added Split View (like 
Full Screen, but for two apps at a time); major improvements to 
Spotlight, Notes, Safari, Maps, and Photos; new system fonts; im-
proved performance; and a security feature called System Integrity 
Protection (SIP), about which you can read in Glenn Fleishman’s 
Macworld article Private I: El Capitan’s System Integrity Protection 
will shift utilities’ functions. 
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Changes in Yosemite 
Still running Mavericks or earlier? In OS X 10.10 Yosemite, Apple 
added Continuity features that enable Macs and iOS devices to work 
together more seamlessly, a significantly redesigned Spotlight, iCloud 
Drive, an expanded Notification Center, and several improvements to 
Mail. 

Yosemite also changed how the Mac handles Java. Java is a popular 
cross-platform programming language, which once enjoyed full sup-
port on the Mac. But largely due to security concerns, Apple stopped 
bundling the Java runtime (the software that enables Java code to run) 
with the Mac operating system. In High Sierra (as in Sierra, El Capitan, 
and Yosemite), a prompt still appears when you try to run Java soft-
ware, directing you to download the Java runtime from Oracle and 
install it manually. 

Changes in Mavericks 
In OS X 10.9 Mavericks, Apple switched from using big cats to Califor-
nia landmarks in the names of its Mac operating systems. Mavericks 
also improved support for multiple displays, added both tags and tabs 
to the Finder, added the iBooks and Maps apps, and introduced 
interactive notifications, all while improving performance on several 
fronts. 

Changes in Mountain Lion 
In OS X 10.8 Mountain Lion, Apple switched from calling the Mac 
operating system “Mac OS X” to just “OS X.” Mountain Lion intro-
duced Messages, Notification Center, Dictation, and Power Nap 
(among many other features). iCal was renamed Calendar, and Ad-
dress Book was renamed Contacts. In addition, Apple added the 
Reminders app to replace the Reminders feature in iCal, as well as a 
new Notes app to replace the Notes feature previously in Mail. 

Mountain Lion also dropped Web Sharing controls in System Prefer-
ences and support for RSS feeds in Apple Mail and Safari. 

12 



         
          

           
           

       
  

  
             

             
            

         
      

          
          

          
         

    

             
        

         
        

           
             

          
   

       
        

          
           

 
             

          

Last but not least, with Mountain Lion, Apple began distributing 
upgrades to the Mac operating system by download only. The High 
Sierra installer is over 5 GB—a problem for people without broadband 
internet connections, or with restrictions on the quantity of data they 
can download. I offer some ways to deal with that problem later, in 
Obtain the Installer. 

Changes in Lion 
I’m guessing that very few readers are still using Mac OS X 10.6 Snow 
Leopard and upgrading all the way to High Sierra. But if you are, you 
may be interested to know that Mac OS X 10.7 Lion added features 
such as iCloud support, Versions and Auto Save, FileVault 2, Launch-
pad, Mission Control, full-screen apps, and multi-touch gestures. 

More significant, however, for people still running Snow Leopard, are 
the following features that disappeared in Lion (and are still gone): 

•	 Rosetta: Rosetta was the software that enabled PowerPC apps to 
run on Intel-based Macs. Upgrading to High Sierra entails living 
without software that requires Rosetta. 

To learn how to find installed apps that still rely on Rosetta, see 
Matt Neuburg’s TidBITS article Preparing for Lion: Find Your 
PowerPC Applications. If you discover any such apps, you must 
upgrade them to Intel-native (or Universal) versions, migrate to 
alternative apps, or find a way to continue running Snow Leopard 
(for example, by keeping it on a separate Mac, drive, or partition; or 
running Snow Leopard Server in a virtual machine using Parallels 
Desktop or VMware Fusion). 

•	 Flash: Adobe’s Flash Player, which enables dynamic web content 
such as video, games, and interactive navigation, was bundled with 
previous versions of the Mac operating system but was removed 
from Lion and remains missing from High Sierra. If you need Flash, 
you can download Flash Player for free from Adobe. However, you 
may have good reasons for wanting to avoid Flash, and to encourage 
the use of more modern standards such as HTML5. John Gruber 
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explains one method of living without Flash in a Daring Fireball 
post. 

Learn about APFS
 

If you’ve ever erased or partitioned a disk in Disk Utility, you’ve proba-
bly seen the term “Mac OS Extended”—it’s one of several file systems 
you can choose from to format a Mac volume, and except for situations 
in which a disk must be usable on non-Mac computers, it has been the 
preferred format since the very beginning of Mac OS X. 

A file system, in case you’re wondering, is a mechanism for storing files 
on a disk or SSD—it’s the technology that enables your computer to 
figure out where all the individual pieces of each file are stored, what 
the files and folders are called, what their other metadata are, and so 
on. In other words, it’s just plumbing—you, as a user, never interact 
directly with the file system, but instead you use a high-level app like 
the Finder to do things like move, copy, rename, and delete files. All 
the gory details of the filing system are handled behind the scenes. 

Mac OS Extended is nearly two decades old, and let’s just say that it 
hasn’t aged especially well. Since this file system was introduced, 
computers and their storage devices have gotten way faster, storage 
capacities have increased dramatically, SSDs have become much more 
popular and far less expensive, and security concerns have become a 
vastly bigger deal. The Mac has been needing a better and more mod-
ern file system for a long time, and High Sierra finally provides it, in 
the form of Apple File System, or APFS (for more on the name, see the 
sidebar Why APFS and Not AFS?). 

“That’s nifty,” you may say, “but if it is just plumbing, why should I 
care?” Well, imagine that your house has rusted pipes, clogged drains, 
and leaky faucets, and then someone comes in and replaces all that. 
Now the dripping faucet doesn’t keep you awake all night, the tub 
drains quickly, and—oh!—that water pressure in the kitchen is some-
thing else! That’s what APFS does for your Mac. 
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For example, duplicating even a multi-gigabyte file is essentially 
instantaneous in APFS. Using the Finder’s File > Get Info command to 
check a folder’s size is also quite fast. (That’s something I’ve frequently 
had to wait many minutes for, and it always drove me crazy!) Many 
day-to-day activities like that will become much faster. And, if you 
have a Mac laptop that uses Time Machine, the temporary backups it 
makes while you’re disconnected from your Time Machine backup disk 
will go much faster and take up far less space; for details, see Mobile 
Time Machine and its transformation in High Sierra. 

APFS is also far more resistant to data loss or corruption due to crash-
es, and it natively supports advanced backup and encryption capabili-
ties that will help keep your data more secure. (And, in case you’re 
wondering, FileVault still exists and still works just fine with APFS— 
even though the underlying encryption mechanism will change during 
the upgrade process, it will look and act the same as it always has.) 

Note: As of October 2017, I’ve been unable to determine how users 
will take advantage of, or interact with, some of the more sophisticat-
ed features of APFS. It may be that some APFS capabilities won’t 
appear in a user-accessible form until a future update to High Sierra, 
or even a later version of macOS. 

APFS can be used on devices of any size (including an Apple Watch). 
In addition, APFS was explicitly designed to work well with fast SSDs, 
and to scale gracefully to storage devices with capacities that are 
unheard of today, but may be commonplace before long. 

As a matter of fact, if you have an iPhone, iPad, or iPod touch running 
iOS 10.3 or later, you’re already using APFS! That’s right, Apple de-
signed the iOS 10.3 installer to quietly convert the file system to APFS 
as it ran. So the process of safely converting to the new format has 
already been field-tested many millions of times! 

To summarize thus far: 

•	 High Sierra will give you the benefits of the new APFS “plumbing,” 
and that will make you happy. 
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•	 The conversion process will be effectively seamless, and the only 
thing you’re likely to notice is that installing High Sierra takes a bit 
longer than you expected. 

But… 

Of course, there had to be a “but.” In fact, there are several, and some 
of them are pretty significant. 

APFS is great, and once the majority of Apple devices are using it, the 
world is going to be a better place. There are, however, a few niggling 
“gotchas,” at least for now: 

•	 First, as of the initial 10.13.0 release of High Sierra, only Macs with 
all-solid-state storage can be converted to APFS. If your Mac con-
tains a spinning hard drive, or a Fusion drive (which combines an 
SSD with a hard drive), you can’t convert your startup volume to 
APFS yet. 

This is a major limitation, and as it appeared partway through the 
public beta testing process, some users running the beta version of 
High Sierra may have allowed the installer to convert their Fusion 
drives to APFS. (This conversion did not occur with hard drives.) 
Unfortunately, High Sierra 10.13.0 cannot be installed at all on a 
non-solid-state device formatted as APFS, yet an APFS-formatted 
drive can’t be converted back to Mac OS Extended without erasing 
it! So, those unlucky Fusion drive users must completely erase and 
reformat their drives, restore a pre-High Sierra backup, and then 
install the release version of High Sierra. Yeah, it’s ugly. Apple 
details the whole messy process in Preparing your Fusion Drive Mac 
for the macOS High Sierra install. 

•	 Assuming your Mac has built-in, solid-state storage, the conversion 
to APFS during installation of High Sierra is both automatic and 
mandatory. You can’t opt out, even though that was an option in a 
few of the early beta versions. 

Note: As of version 10.13.0, the High Sierra installer apparently does 
not convert external SSD boot drives to APFS automatically. 
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•	 The High Sierra version of Disk Utility, including the copy available 
when running in macOS Recovery, can convert volumes from Mac 
OS Extended to APFS, without losing data (choose Edit > Convert to 
APFS). In fact, this process even works on some spinning hard 
drives (so far, I’ve been unable to determine why it works on some 
but not others), though the command is dimmed if any non-solid-
state startup volume is selected. But I advise against doing such 
manual conversions for now, especially on non-SSD volumes, 
because it’s clear that APFS still has significant kinks to be worked 
out—and because, as I mentioned, you can’t reverse the process. 

Warning! Do not attempt to reformat a Time Machine backup disk as 
APFS, as High Sierra will be unable to use it (regardless of whether 
your startup disk is formatted as APFS), and you’ll have to erase it 
and start your backups over from scratch. This may change in the 
future, but for now, leave your Time Machine disk formatted as Mac 
OS Extended. 

•	 Macs running El Capitan or earlier can’t mount or read volumes 
formatted with APFS. (If a Mac can run High Sierra, it can boot 
from an APFS-formatted volume, even if the normal boot volume 
uses El Capitan or earlier. But while booted from El Capitan or 
earlier, it can’t read an APFS volume.) 

In other words, if you have an external SSD formatted as APFS, and 
you install High Sierra onto it, you can boot a Mac from that drive— 
but if you disconnect that drive and connect it to a Mac that’s 
already booted from El Capitan or earlier, that Mac won’t be able to 
read anything on it. 

Note: Sierra 10.12.6 or later can read APFS-formatted volumes, but 
you can’t create a bootable Sierra APFS volume. High Sierra is the 
first version of macOS that can boot from an APFS volume. 

•	 Some virtualization apps that otherwise support High Sierra may 
not support APFS-formatted High Sierra volumes. If you use 
VMware Fusion or Parallels Desktop and want to run High Sierra as 
a guest operating system, be sure you’ve updated your software to 
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the latest version—and check with the developer for any limitations 
or special instructions. 

•	 Third-party disk utilities must be updated to work with APFS. If you 
use DiskWarrior, Drive Genius, TechTool Pro, or other apps to 
perform disk maintenance or repair, be sure to check for an APFS-
compatible update before you run it under High Sierra, or bad 
things can happen. 

Having said all that, I think that the potential problems with APFS will 
affect only a tiny fraction of a percent of High Sierra users. Users with 
SSDs startup drives will get APFS automatically and, I expect, will 
enjoy the improvements that the new file system brings, while those 
with Fusion drives and hard drives can simply ignore the existence of 
APFS entirely unless or until Apple adds it to a future version of 
macOS. 

Why APFS and Not AFS? 
Somebody has to say it: Apple has a hard time picking good names 

for its file systems.
 

Way back in 1985, Apple introduced the Hierarchical File System, or
 

HFS, as the standard way to format a Mac hard disk. In 1998, an
 

enhanced version of the file system, HFS Plus, was introduced, and 

became the default for Mac OS X.
 

At some point, Apple decided that “Mac OS Standard” was a better 
way to refer to HFS, and “Mac OS Extended” was a better way to 
refer to HFS Plus. (Apple briefly called it “OS X Extended.”) So those 
longer names have been used (for example, in Disk Utility) for quite 
some time, even though HFS and HFS Plus are so much less cumber-
some—and Apple hasn’t had software called “Mac OS” since 1999. 

Then Apple File System comes along, and any reasonable person
 

might expect it to be shortened to AFS. But no: that initialism was 

already in use, for a network technology called Apple File Service. 

Thus we’re left with the clunky term APFS, which can only be parsed 

as APple File System. Geez.
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Check Your Mac for 
Compatibility 

All currently shipping Macs, as well as models introduced within the 
past 7 years or so, can run High Sierra. In fact, the system require-
ments are unchanged from 10.12 Sierra, so if your Mac can run Sierra, 
you know it can run High Sierra too. If your Mac is older or not already 
running Sierra, however, you’ll want to make sure it is compatible. 

In addition, even if your Mac can run High Sierra, you may not be able 
to use every part of it. Certain features, such as Handoff and AirDrop 
between a Mac and an iOS device, require a recent version of Blue-
tooth—see Recent Bluetooth Hardware for an explanation. 

The next several pages will help you verify that your hardware is fully 
compatible with High Sierra. And, if you’re running 10.7 Lion or 10.6 
Snow Leopard, follow the advice in OS X 10.8 Mountain Lion or Later 
in order to use the High Sierra installer. 

Model Support
 

High Sierra does not support Mac models introduced before late 2009. 
Macs that can run High Sierra include the following: 

• iMac (Late 2009 or newer) 

• MacBook (Late 2009 or newer) 

• MacBook Air (Late 2010 or newer) 

• MacBook Pro (Mid 2010 or newer) 

• Mac mini (Mid 2010 or newer) 

• Mac Pro (Mid 2010 or newer) 
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Of course, that list is helpful only if you know which model of Mac you 
have! If your Mac is running Lion or later, this is easy to check: choose 
Apple  > About This Mac and (if needed) then click More Info. You’ll 
see something like Figure 1; the Overview pane spells out your Mac’s 
model using Apple’s current terminology. 

Figure 1: This window on Macs running Lion or later gives you the 
exact marketing name of your Mac model. 

However, if your Mac is running Snow Leopard, nowhere on your 
Mac can you see these designations (like “Late 2009”). Instead, you’ll 
have to go by your Mac’s Model Identifier. To find it, open System 
Profiler (in /Applications/Utilities). In the list on the left, make sure 
Hardware is selected, and look for the line that says Model Identifier. 
It consists of your Mac model name followed by a pair of numbers, 
without spaces—as in MacBook6,1. 

Once you know your Mac’s Model Identifier, you can look it up in my 
enhanced version of Apple’s list, below. (Keep in mind that the comma 
should be interpreted as a decimal point, so 6,2 is newer than 6,1, and 
6,1 is newer than 5,6.) 

Here are the Macs that can run High Sierra: 

• iMac10,1 or newer 
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• MacBook6,1 or newer 

• MacBookAir3,1 or newer 

• MacBookPro6,1 or newer 

• Macmini4,1 or newer 

• MacPro5,1 or newer 

If your Mac isn’t on that list (or has an older model number), then 
regardless of its age or speed, I’m very sorry to say that it won’t run 
High Sierra. 

New Macs that ship after High Sierra is released will have High Sierra 
preinstalled; if necessary, you can use the Migration Assistant to 
transfer files, accounts, and settings from your old Mac, as I explain in 
my TidBITS article How to Migrate to a New Mac. 

RAM
 

High Sierra requires a minimum of 2 GB of RAM, and all Macs that 
can run High Sierra shipped with at least that much. But even though 
2 GB is the official minimum, I strongly suggest having at least 4 GB— 
or even more, if your budget allows and your Mac’s RAM is user-
upgradable. 

In general, the more RAM you have, the better your Mac’s perfor-
mance. If your Mac can hold 16 GB of RAM or less, I recommend 
maxing it out if possible. If it can hold more than 16 GB and you’re 
doing heavy-duty video, audio, or graphics work, you might want to go 
even higher. But very few people would benefit from the maximum of 
64 GB of RAM you can put in a Mac Pro or the 128 GB you’ll be able to 
put in an iMac Pro (when it appears in late 2017). 

To see how much RAM your Mac currently has installed, choose 
Apple  > About This Mac and look at the Memory line. 
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How Much RAM Can My Mac Hold? 
If you are in a position to increase the RAM in your Mac, you’ll want 
to know how much it can actually use. To determine the RAM limit for 
a Mac running Lion or later: 

1. Choose Apple  > About This Mac. 

2. If you see a More Info button, click it (the button isn’t present in 
newer versions of macOS). 

3. If you see a Memory button, click it. (If you don’t, your RAM isn’t 
upgradable.) 

System Information should tell you how much RAM is installed and 
how much your Mac can accept. For further details and information 
on how to add RAM, click the Memory Upgrade Instructions link (if 
present; if not, your Mac’s RAM is not user-upgradable). 

Firmware Updates
 

Some Macs may require updated EFI or SMC firmware to run High 
Sierra. To see if a firmware update is available, check this webpage. 
Unless you previously hid them from the list, firmware updates should 
also appear when you choose Apple  > App Store and click Updates 
(in Yosemite and later) or Apple  > Software Update (Mavericks and 
earlier). 

Note: The High Sierra installer itself can, in some situations, down-
load and apply firmware updates, but you shouldn’t count on it 

working in every case; it’s better to do this operation separately.
 

Free Disk Space
 

Apple says that the High Sierra installer requires 14.3 GB of free 
storage space to perform the upgrade (and that after the installation is 
finished, High Sierra will occupy about 1.5 GB more than Sierra did). 
Although you may be able to get away with exactly 14.3 GB free, you’ll 
be doing yourself a favor by not cutting it so close. I recommend 
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starting with at least 20 GB of free space (before downloading the 
installer). More free space is even better, of course. Some High Sierra 
features will require increasing amounts of disk space as you use them, 
so it never hurts to have room to grow. 

Tip: To find out how much free space a volume has, select the 
volume’s icon in the Finder and choose File > Get Info. The window 
that appears lists (among other things) the volume’s Capacity (total), 
Available (free), and Used space. 

If you’re running out of disk space, skip ahead to De-clutter Your Disk 
for suggestions as to how you can remedy the problem. 

Recent Bluetooth Hardware
 

Although it’s not a requirement for High Sierra as such, if you want to 
use certain Continuity features, including Handoff, Instant Hotspot, 
Universal Clipboard, AirDrop (when used for file transfers between a 
Mac and an iOS device), and unlocking your Mac with an Apple 
Watch—or if you want to use Apple Pay on the web—your Mac needs to 
have built-in support for a recent version of Bluetooth. 

For all the above features except Auto Unlock with Apple Watch, your 
Mac must be among the following: 

• iMac: 2012 or newer 

• MacBook: Early 2105 or newer 

• MacBook Air: 2012 or newer 

• MacBook Pro: 2012 or newer 

• Mac mini: 2012 or newer 

• Mac Pro: Late 2013 or newer 

For Auto Unlock with Apple Watch, you must have a Mac introduced 
in 2013 or later, plus an Apple Watch with watchOS 3 or later, and 
an iPhone 5 or later with iOS 10 or later. If you want to use Apple Pay 
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on the web in Safari on your Mac, you also need an iPhone 6 or later 
with iOS 10 or later, or an Apple Watch with watchOS 3 or later. 

To find out which Mac model you have, flip back to Model Support. 

OS X 10.8 Mountain Lion or Later
 

Previous versions of this book said that High Sierra requires only OS X 
10.7.5 Lion or later, but Apple apparently made a late change to the 
requirements: in order to install High Sierra, your Mac must be run-
ning 10.8 Mountain Lion or later. 

If your Mac supports High Sierra but is currently running 10.6 Snow 
Leopard or 10.7 Lion, you must upgrade it to 10.11 El Capitan before 
you can install High Sierra. (The steps are just like those found later in 
this book for High Sierra, except that you’ll download El Capitan from 
the App Store. The reason you must install El Capitan rather than 
Mountain Lion is that Mountain Lion is no longer available from the 
App Store, but El Capitan is.) And, if your Mac is running a version of 
10.6 earlier than 10.6.8, you’ll have to choose Apple  > Software 
Update to install the 10.6.8 update before you can even download El 
Capitan—and then upgrade to High Sierra. 

In addition to having 10.8 or later, you’ll also want to Update Your 
Third-party Software before installing High Sierra. 
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Back Up Your Disk 
If you’ve read pretty much any book I’ve written about the Mac, you 
know I consider a solid backup plan to be essential for every Mac user. 
I hope you already perform backups regularly, and if you don’t, this is 
a perfect time to start. 

Regardless of what you do normally (such as using Time Machine or 
Backblaze), I want to state emphatically that before upgrading to High 
Sierra, you should create a specific type of backup called a bootable 
duplicate. That’s an exact copy of everything on your startup volume, 
stored on another disk in such a way that you could start up your Mac 
from that other disk and it would behave precisely as it does when you 
boot from your regular startup volume. 

Even though the High Sierra installer doesn’t force you to make this 
type of backup, it’s not something you can safely skip if it’s inconve-
nient or if you’re fairly sure you won’t have problems. In my profes-
sional opinion, creating a duplicate is a mandatory, integral part of the 
upgrade process. In this chapter I tell you both why and how to do this. 

Note: I say “volume” here rather than “disk” because your startup 
volume could be an SSD (solid-state drive). Some Mac models use 
what Apple calls “solid-state storage,” which is different from an SSD 
only in its physical configuration. I’ll use the term “SSD” to refer to 
any type of solid-state storage. 

After you duplicate your startup volume, I’m going to tell you to do 
some spring cleaning (see Clean Up Your Mac), and then I’m going to 
tell you to update your duplicate. I wanted to warn you about this up 
front so you know it isn’t a mistake or capricious advice—it’s for your 
own good. You need a great backup before you delete any files (in case 
you accidentally delete something you need), but you also need a 
freshly updated backup right before installing High Sierra. 
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Let me also point out that whatever the virtues of Time Machine, it’s 
no substitute for a bootable duplicate, as I explain in the sidebar But I 
Really Don’t Want to Make a Duplicate!. 

Tip: Upgrading or not, every Mac user should have a thorough
 

backup strategy; you can learn how to minimize downtime and 

thoroughly protect your important information by reading my com-
prehensive book Backing Up Your Mac: A Joe On Tech Guide.
 

Why You Need a Duplicate
 

As I said, the particular type of backup you want at this moment— 
regardless of any other backups you may have—is a bootable duplicate, 
which is a clone or mirror image of everything on your startup volume. 
You can’t make a bootable duplicate in the Finder by dragging and 
dropping files onto another disk, and backup programs like Time 
Machine and Backblaze (though they’re both fantastic for what they 
do) can’t make them either. You must use a backup program that’s 
designed specifically for making a bootable duplicate. 

Everyone should create a bootable duplicate and update it regularly 
(at least once a week) as part of a solid backup regimen. In day-to-day 
use, duplicates are important because they let you get back to work 
almost instantly in the event of a major disk error or even a complete 
failure of your hard drive or SSD. You simply plug in the backup drive, 
reboot while holding the Option key, and select the external drive, and 
you’re back up and running. You can then use the backup disk to repair 
your internal startup volume and restore your files—or if the drive is 
too far gone, replace it at your leisure. 

However, aside from that “nice-to-have” reason for making a duplicate, 
you truly need one when it comes time to upgrade your operating 
system. Despite Apple’s valiant efforts at idiot-proofing the installer, 
something could go wrong—either during the upgrade or afterward— 
that deletes important files, leaves your disk unusable, or results in 
your needing to revert to your previous version of macOS. Bootable 
duplicates let you recover from these situations handily. 
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In addition, you may choose (for reasons discussed later, in Plan B: 
Clean Install) to erase your entire startup volume, install a clean copy 
of High Sierra, and then copy your personal files, third-party software, 
and other data back to your High Sierra volume. To be sure you have 
everything you might need during this process (and in exactly the right 
form), you must have a bootable duplicate. 

Prepare for a Duplicate
 

To create a duplicate, you’ll need a few hardware and software ingredi-
ents, and you’ll need to follow a few preliminary steps. 

Hardware 
You’ll need an empty hard drive for your duplicate. If you don’t happen 
to have an extra (internal or external) hard drive, take heart: hard 
drives are pretty cheap these days. For example, you can easily find a 
4 TB external drive for less than $120, and compared to the cost of 
losing your data, that’s quite reasonable. Look for one with a fast 
interface (Thunderbolt 2 or 3, or USB 3), and with enough capacity to 
accommodate your growing backup needs over the next few years. 

Software 
Many (but not all) backup apps can create bootable duplicates. If you 
don’t yet have a suitable tool, try Carbon Copy Cloner or SuperDuper. 
These two apps operate similarly and are easy to use. 

Which Volumes to Duplicate 
You should create duplicates of your primary startup volume and any 
other volume on the same physical media. If you have a single, unpar-
titioned hard disk or SSD, then you have only a single volume to worry 
about. If you have multiple partitions (or multiple internal or external 
hard drives or SSDs) that contain bootable systems, I recommend 
making duplicates of all of them. 
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Prepare Your External Drive 
Before you can create your duplicate, you must perform a few quick 
steps to partition and format your disk. If the drive is already empty 
and properly formatted, you can skip these steps. But many new hard 
drives come formatted in a way that’s incompatible with bootable 
duplicates. (For example, I recently bought a 4 TB Seagate backup 
drive that came formatted as NTFS and included special software 
needed to use the drive on a Mac. That’s fine for ordinary backups, but 
it won’t work for a bootable duplicate.) 

Gone, gone, gone! This process erases everything on the drive—
 

which should be no problem if it’s a new drive. If you already have
 

important files on the drive, be sure to copy them elsewhere first!
 

To prepare your drive, connect it to your Mac, turn it on, and launch 
Disk Utility (in /Applications/Utilities). In the list on the left, select 
your external disk. (The disk is the topmost icon in any group, with any 
volumes it contains indented beneath it.) The remaining steps depend 
on which operating system your Mac is using. 

Configure a Drive in El Capitan or Later 
Follow these steps in Disk Utility, with your external disk selected: 

1.	 Click the Erase button on the toolbar. 

2.	 In the dialog that appears, type a name for your disk in the Name 
field. Leave the Format pop-up menu set to Mac OS Extended 
(Journaled) or OS X Extended (Journaled), choose GUID Partition 
Map from the Scheme pop-up menu (if present), and click Erase. If 
you want your disk to have a single partition, you’re done; skip the 
remaining steps. (One partition is usually fine; to put both a dupli-
cate and other backup data on the drive, make two partitions.) 

Note: Why not use the new APFS format? Generally speaking, that 

option is available only if the drive was formatted on a Mac that’s 

already running High Sierra or later. See Learn about APFS.
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3.	 To add a partition, leave the disk selected on the left and click Parti-
tion. A dialog appears with a pie chart showing a single partition on 
the disk. 

4. Click the plus button to add a partition (Figure 2). Enter a 
name for the second partition in the Name or Partition field and 
leave the Format set to Mac OS Extended (Journaled) or OS X 
Extended (Journaled). To adjust the size of the partition, drag the 
handle on the pie chart or type a new number in the Size field. 
Repeat this step if you want to add more partitions. 

Figure 2: Use this dialog to configure a secondary partition in
 
El Capitan or later. (Details vary based on your operating system.)
 

5.	 Click Apply. 

Disk Utility has now erased your disk and added any partitions that 
you specified. If you see an alert asking whether you want to use the 
new volume for Time Machine, click Don’t Use, since you’ll be using 
different software to create your bootable duplicate. 

Configure a Drive in Yosemite or Earlier 
Follow these steps in Disk Utility, with your external disk selected: 

1.	 Click the Partition button. 
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2.	 From the Partition Layout pop-up menu (called Volume Scheme in 
Snow Leopard), choose the number of partitions you want—do not 
leave it set to Current, even if you want to keep the same number 
of partitions. One is usually fine; to put both a duplicate and other 
backup data on the drive, make two partitions. 

3.	 For each partition, give it a name and choose the Mac OS Extended 
(Journaled) format. 

4.	 If you’ve chosen to create more than one partition, resize the parti-
tions manually by dragging the dividers, or enter a size for each 
partition. (The first partition must be at least as large as the amount 
of data on your startup volume.) 

5.	 Click Options. In the dialog that appears, select GUID Partition 
Table. Click OK. 

6.	 Click Apply, and then click Partition. 

Now that you’ve partitioned and formatted your disk, quit Disk Utility. 
If you see an alert asking whether you want to use the new volume for 
Time Machine, click Don’t Use, since you’ll be using different software 
to create your bootable duplicate. 

Create a Duplicate
 

Creating a bootable duplicate with either of my recommended utilities 
is quite easy: you simply choose a source disk (your existing startup 
volume) and a destination disk (your backup drive), specify a few 
options, and click a button. Although each backup app comes with its 
own instructions, here’s a quick overview of how to create a bootable 
duplicate with Carbon Copy Cloner ($39.99, free 30-day trial 
available), my personal favorite. 

Note: If you’re running Carbon Copy Cloner 3.5.7 (which you will be 
in 10.7 Lion or earlier), the interface will be different from the one 
shown in the directions below, but the basic process is the same—just 
skip the step about turning off the SafetyNet switch. 
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To create a duplicate with Carbon Copy Cloner, follow these steps: 

1.	 Launch Carbon Copy Cloner (Figure 3). 

Figure 3: Carbon Copy Cloner shows you the source, destination, 
options, and an explanation of what’s going to happen. 

2.	 Click in the center of the SOURCE area, and select your startup 
volume from the popover that appears. 

3.	 Click in the center of the DESTINATION area, and select the disk 
or partition set aside for duplicates on your external disk from the 
popover that appears. 

4.	 Under the DESTINATION area, if you’re using version 4.x of 
Carbon Copy Cloner, make sure the SafetyNet switch is set to Off. 
If you’re using version 5.x, choose SafetyNet Off from the pop-up 
menu. 

5.	 Click Clone and follow the prompts—you may be asked to enter your 
administrator password to make an immediate duplicate, and you 
may also be asked to install a helper tool (which is a good idea). 
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Carbon Copy Cloner creates the duplicate and displays a message when
 
your backup is complete. This process may take several hours or more
 
(depending on the size and speed of your drive, among other factors).
 

Test Your Duplicate
 

Even if your backup app reported no errors, you should test the dupli-
cate to make sure it truly is bootable before taking the plunge and 
upgrading to High Sierra. Follow these steps: 

1.	 Make sure the drive with your duplicate is connected to your Mac. 

2.	 Choose Apple  > Restart. 

3.	 Immediately press and hold the Option key until you see a screen 
with an icon for each available startup volume. 

4.	 Click the volume containing your duplicate (or use the arrow keys to 
select it) and press Return. 

Be prepared to wait much longer than usual for your Mac to start 
up—as much as 10–15 minutes. Longer boot times are normal when 
starting a Mac from any new volume, but the time can be longer still 
if your backup drive uses a slow interface, such as USB 2.0. 

5.	 When your Desktop appears, you may see alerts about supplying 
passwords for services such as iCloud, Messages, FaceTime, and 
Dropbox; you can ignore and dismiss these since you’re only con-
ducting a brief test. Verify that your Mac used your duplicate as the 
startup volume. (If in doubt, choose Apple  > About This Mac and 
see what’s listed next to Startup Disk.) 

6.	 Do a few spot checks to confirm that important files are where they 
should be, that you have network access (try viewing a news page on 
the web), and that a few apps launch. I recommend not checking 
your email, though, as doing so may download messages and delete 
the originals from the server—you’ll miss them when you return to 
your usual startup disk. 

7.	 Choose Apple  > Restart to boot from your normal startup volume. 
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You’ve just confirmed that your duplicate works correctly. 

But I Really Don’t Want to Make a Duplicate! 
I recognize that some readers may bristle at my insistence on a
 

bootable duplicate, especially if they already have other types of
 
backups. So I want to take a moment to explain why I say this:
 

it’s because I care! I’m trying to save you time and grief.
 

If you have no backups, then the only installation method open to 
you is an in-place upgrade (see Plan A: In-place Upgrade). If some-
thing goes seriously wrong during the upgrade, you could end up 
without a bootable disk—and switching to Plan B (see Plan B: Clean 
Install) would be impossible unless you’re willing to erase your entire 
disk and lose all your data! And, if the installation succeeds but you 
later discover a serious software incompatibility or other problem, 
you would be unable to return your system directly to its previous 
state; downgrading would become much more complicated. 

But suppose you do have a backup of some kind—but not a bootable 
duplicate. Then you’re in less danger, right? Well, maybe. If you have 
a Time Machine backup, as Apple recommends, you could indeed use 
it (in lieu of a bootable duplicate) to transfer data after a clean install, 
and you could also use it to restore your disk to its previous state 
should that become necessary—but it’s an awkward procedure that 
often takes much more time than restoring from a bootable duplicate. 

A bigger worry with Time Machine is that you may have configured it 
to exclude certain files or folders. And anything Time Machine didn’t 
back up can’t be restored! Besides, you can’t boot directly from your 
Time Machine backup as you can from a duplicate, so you can’t use it 
run your computer temporarily if the need arises—your only option is 
to spend many hours restoring your entire disk. 

If you used some other backup app, then again, the in-place upgrade 
is your only option, because transferring data from your backup at 
the end of a clean install is impossible. You may or may not (depend-
ing on the app and how you have it set up) be able to return your 
disk to its previous state if needed, but the process is sure to be 
more complicated and time-consuming. 

Simply put, in my professional opinion, a bootable duplicate is a
 

crucial safety net and the best way to minimize inconvenience.
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Clean Up Your Mac 
Over time, most computers accumulate clutter, including outdated 
software, forgotten downloads, and obsolete files. Not only can this 
clutter make files harder to find, it can also cause problems when you 
upgrade to High Sierra—incompatibilities may show up, or you may 
run out of disk space, for example. 

In this chapter, I suggest that you install some software updates and 
delete files you don’t need anymore. I also show you how to check both 
your RAM and your disk for errors that could cause problems when 
installing or running High Sierra. 

Because you’ll be making so many changes, you should first make a 
complete backup—so if you skipped Back Up Your Disk, go back and 
follow those steps now. After you’ve cleaned up your Mac, restarted, 
and verified that everything is working properly, you should Update 
Your Duplicate so that it’ll be closer to the state of your disk when you 
upgrade to High Sierra. 

Update Your Third-party Software
 

Every major upgrade to the Mac operating system results in software 
compatibility problems, where some apps work poorly or won’t launch. 
Most of us will have to update at least a few apps to make them work 
correctly under High Sierra. If history is any indication, some incom-
patible apps won’t be updated right away, and a few might never be. 
But many developers work hard to ensure that their software is ready 
for each new version of macOS, and “High Sierra-compatible” software 
updates have already been appearing for months. 

Tip: RoaringApps maintains a wiki listing hundreds of Mac and iOS 
apps and the current status of their compatibility with various operat-
ing system versions, as reported by users. Although this list is neither 
exhaustive nor definitive, it provides a quick way to check on the 
apps most important to you. 
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About Microsoft Office and High Sierra 
In the weeks before the release of High Sierra, some misinformation 
was circulating about Microsoft Office compatibility. Here’s what I 
know, based on Microsoft’s support article Microsoft Office support for 
macOS 10.13 High Sierra: 

✦	 Microsoft Office 2016 for Mac, version 15.35 and later, is compati-
ble with High Sierra, although it is not guaranteed to be bug-free. 
Microsoft intends to release an update, if necessary, soon after High 
Sierra is available. 

✦ Older versions of Microsoft Office 2016 for Mac (that is, 15.34 and 
below) might have a variety of problems, including not launching at 
all. If you have such a version, update your copy of Office immedi-
ately. 

✦ Microsoft Office for Mac 2011 is unsupported under High Sierra. It 
may or may not work, but as Microsoft support runs only through 
October 10, 2017, the company has no plans to make it compatible 
with High Sierra. 

Long story short: If you use Microsoft Office, install the very latest 

version (or switch to a completely different set of apps); anything 

else, and you’re taking your chances.
 

The High Sierra installer looks for, and disables, certain types of 
incompatible software—but there’s no guarantee it will find everything. 
Given the choice, you’re usually better off upgrading third-party 
software before you install a new version of your operating system. In 
cases where low-level incompatibilities exist, especially with things like 
drivers, preference panes, and kernel extensions, you can save yourself 
grief by preventing, rather than fixing, the problem. 

Apple built an update mechanism into the App Store, so any apps you 
downloaded from the App Store can also be updated there—and App 
Store updates are free. To check for and apply App Store updates: 

1.	 Open the App Store app by choosing Apple  > App Store. (In 
Mavericks or earlier, choose Apple  > Software Update.) 

2.	 Click Updates in the toolbar to display a list of available updates. 
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3.	 To update a single app, click the Update button next to it. Or, to 
update all the listed apps at once, click Update All. 

4.	 If prompted to do so, enter your Apple ID and password, and click 
Sign In. 

The App Store downloads and installs the updates automatically. 

Note: Even though updates from the App Store are free, some
 

developers release entirely new apps (which require an additional
 
purchase) to replace older apps. Which app version you use may
 

depend on the version of macOS you’re running.
 

Software that doesn’t come from the App Store must use a separate 
update mechanism. Happily, most modern apps contain some sort 
of update feature. Unhappily, they don’t all work the same way. Some 
check for updates every time they’re launched, or on a fixed schedule, 
while others check only on demand; of those that do check automati-
cally, not all have this feature turned on initially. Some programs can 
download and install new versions of themselves automatically, while 
others download a disk image and expect you to open it and run the 
installer yourself; still others do nothing but open a webpage with links 
to updates you can download manually. 

Note: No matter how diligently you apply updates, you may find 

some software that still needs updating after you install High Sierra,
 
because the newest version of the app may not run on your older
 

version of macOS.
 

For now, do the following. In each non–App Store program that you 
use frequently, look for a Check for Updates command (the wording 
may vary). Such commands (Figure 4) usually appear in the applica-
tion menu, the Help menu, or the Preferences window. 
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Figure 4: In some apps, such as Transmit (left), the Check for 
Updates command appears in the application menu—the one with 
the same name as the app. In others, such as Excel (right), it ap-
pears in the Help menu. Wording may also differ between apps. 

While you’re at it, check each app’s Preferences dialog for a checkbox 
that enables scheduled updates, and if you can choose how often to 
check, choose the most frequent option. That way, even if an update 
isn’t available now, you’ll be informed as soon as the next update 
becomes available and you launch the app. 

Tip: Remember to check for updates of preference panes, status 

menus, Mail plug-ins, browser extensions, and other system en-
hancements too.
 

If you’ve installed any Unix software on the command line, that will 
need to be updated too—and, in some cases, relocated. Unfortunately, 
much software of this sort is compiled specially for each version of 
macOS, so those updates—unlike most software updates—are better 
performed after you upgrade to High Sierra. See Final Software Advice, 
later, for details. 

De-clutter Your Disk
 

Over time, your disk accumulates obsolete, extraneous, or otherwise 
useless apps and files, often called cruft—hacker slang for digital 
detritus. Removing cruft increases the disk space available for High 
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Sierra (see Free Disk Space) and reduces the chance of software con-
flicts. 

Determining which files you need and which can go may be quite a 
task. My advice is not to worry about removing every last obsolete file. 
However, you should at least go through your ~/Downloads folder (and 
any other location where you may store downloads) and delete large 
files you no longer need, and then take a quick spin through /Ap‐
plications, /Applications/Utilities, and System Preferences to 
remind yourself of anything you’ve installed over the past year but 
never use. 

Note: In Sierra, you can also go to Apple  > About This Mac > 
Storage > Manage > Review Files to see options for removing some 
of the items that take up a lot of space on your disk, but in my 
opinion, this window provides too little information and insufficiently 
fine-grained control, making it far too easy to accidentally delete 
more than you should. 

An better way to declutter your disk is to use a utility that can safely 
uninstall software, purge your disk of unneeded resource files, and 
identify old and large files you may be able to do without. The tool I 
prefer for these sorts of tasks is CleanMyMac 3 (read my review in 
TidBITS for details), although there are numerous alternatives. 

Whether you delete things manually or with the help of an app, be sure 
to empty the Trash (choose Finder > Empty Trash) afterward to 
recover the disk space that the files occupied. 

If you’d like extensive, detailed advice on how to do a more thorough 
spring cleaning, as well as ongoing steps you can take to keep your Mac 
humming, see my book Maintaining Your Mac: A Joe On Tech Guide. 

Run Disk Utility
 

Over time, your disk can develop errors without manifesting obvious 
symptoms at first; such errors could interfere with installing High 
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Sierra or cause your Mac to misbehave afterward. You can nip many 
such problems in the bud with a simple procedure that looks for, and 
fixes, common disk errors that can crop up without your knowledge. 

Use Disk Utility in El Capitan or Later 
If your Mac is running El Capitan or later, follow these steps: 

1.	 Launch Disk Utility (in /Applications/Utilities). 

2.	 In the list on the left, select your startup volume (if it isn’t already 
selected), which is indented underneath the name of the device 
(hard drive or SSD) that contains it (Figure 5). 

Figure 5: In Disk Utility, volume names are indented beneath device 
names; here, a volume (Macintosh HD) is selected. 

3.	 Click First Aid on the toolbar, and then click Run. Disk Utility 
checks your disk and repairs it if necessary. 

4.	 When the repair is finished, click Done and quit Disk Utility. 
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Use Disk Utility in Yosemite or Earlier 
In Yosemite or earlier, Disk Utility can’t repair the volume you booted 
from, so you’ll have to use a different procedure that requires a sec-
ondary startup volume. Follow these steps: 

1.	 Start up your Mac from media other than your regular startup 
volume that also contains Disk Utility. This could be, for example: 

‣	 A bootable duplicate of your startup disk stored on an external 
hard drive or a second internal drive 

‣	 A Mac OS X installation DVD or CD 

‣	 A USB Software Reinstall Drive 

‣	 The hidden Recovery HD volume on a Mac running 10.7 Lion or 
later, which enables OS X Recovery (choose Apple  > Restart 
and immediately press and hold Command-R to start in OS X 
Recovery) 

2.	 Run Disk Utility: 

‣	 If you’re running from a bootable duplicate, you can find Disk 
Utility in /Applications/Utilities. 

‣	 If you’re running from a Mac OS X installation disc or USB 
Software Reinstall Drive, click through the language selection 
screen and then choose Utilities > Disk Utility. 

‣	 If you’re using OS X Recovery, click through the language selec-
tion screen if it appears, and then select Disk Utility and click 
Continue. 

3.	 At the left, select your regular startup volume (the one to repair, not 
the one from which you’re currently booted). 

4.	 On the First Aid pane to the right, click Repair Disk. 

Disk Utility looks for common errors and repairs them if possible. 
Ordinarily, it displays a message saying that repairs were completed 
or that no repairs were necessary. 
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5.	 Quit Disk Utility. 

6.	 Restart your Mac: 

‣	 If you find yourself within the installer, quit the installer too; 
then, click Startup Disk, select your main disk, and click Restart. 

‣	 Otherwise, choose Apple  > Restart. 

If Disk Utility encounters a serious problem that it cannot solve, you 
may need to use a commercial repair tool such as DiskWarrior, which 
most experts recommend as their top pick—or restore your entire disk 
from a bootable duplicate or other full backup. Alternatively, you could 
erase your entire disk (after updating your duplicate one last time) and 
start over from scratch with High Sierra, transferring all your apps and 
personal files from your duplicate after the installation, as I describe in 
Plan B: Clean Install. 

Update Your Duplicate
 

Now that your disk is updated with the latest software, cleansed of 
space-hogging residue, and verified as functioning properly, you 
should update your duplicate so it reflects the latest and greatest state 
of your disk. To do so, repeat the steps in Create a Duplicate. With 
Carbon Copy Cloner (and most other backup software), updating a 
duplicate is much quicker than creating one from scratch, because only 
the files changed since the last duplicate are copied. 

Consider Disabling Encryption
 

If your Mac is already running 10.7 Lion or later and has FileVault 
enabled, you need not disable it. If FileVault is enabled in Lion or later 
when you upgrade to High Sierra, it’ll still be active at the end of the 
process (although behind the scenes, it will use the new encryption 
method build into APFS—see Learn about APFS). 
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However, if you have FileVault enabled in 10.6 Snow Leopard, you 
should turn it off (in System Preferences > Security & Privacy > 
FileVault) before installing High Sierra. In addition, if you’re using 
third-party software to encrypt your whole disk—I’m thinking of 
products like Check Point Full Disk Encryption and Symantec 
Endpoint Encryption—check with the developer before you upgrade to 
High Sierra to confirm that the version you’re already using is 
compatible. If not, or if you’re unsure, the safest course of action is to 
disable the encryption before upgrading. Thereafter, you can either re-
encrypt your disk with the same product or switch to FileVault. 
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Decide on an 
Installation Method 

The High Sierra installer doesn’t give you many options, but you can 
still approach the process in either of two ways: 

•	 Plan A: In-place Upgrade: This easy, default method is appro-
priate for most people (including anyone Upgrading from the High 
Sierra Beta), with some qualifications. 

•	 Plan B: Clean Install: Although the installer offers no built-in 
option to start fresh by erasing your disk, you can accomplish the 
same thing in a slightly roundabout way. 

Most users should start with Plan A and then if (and only if) they 
encounter problems, move on to Plan B. A few people may want to skip 
Plan A and go directly to Plan B. In almost every case, the end result 
will be virtually identical, regardless of which path you take. 

In the pages that follow, I describe the differences between these two 
plans and help you choose which way to go. Then, in later chapters, I 
give you step-by-step instructions for each plan. 

Upgrading a New Mac 
If your “upgrade” involves not only upgrading a new (or new to you) 
Mac to High Sierra but also moving your files to the new Mac from an 
old computer, you should generally choose Plan B: Clean Install so 
that you can get a fresh start on the new Mac. At the end of the 
Plan B installation, Setup Assistant will run, letting you transfer the 
files from your old Mac or PC to your new Mac. 

However, if the new Mac contains software that you can’t replace 
after erasing the disk in Plan B, you can do Plan A: In-place Upgrade 
and then run Migration Assistant immediately after rebooting in High 
Sierra. See my TidBITS article How to Migrate to a New Mac. 
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Upgrading from the High Sierra Beta 
If you previously installed the High Sierra public beta and are now 
upgrading to the final High Sierra release, you can still choose from 
Plans A and B—nothing changes there, because it’s possible to do 
either an in-place upgrade from the beta to the final version or a 
clean install of the final version that migrates data from the beta. 

There’s one important exception, however: If you installed an early 
beta version of High Sierra on a Mac with a Fusion drive and let the 
installer convert your drive to APFS, you must erase and reformat the 
drive, and reinstall Sierra from a backup, before proceeding. See 
Learn about APFS for details. 

If you installed the High Sierra beta on a separate volume—not your 
ordinary startup volume—and didn’t save any files on that separate 
volume, my advice is to restart from your main Sierra volume, create 
a bootable duplicate of your startup volume, and then choose Plan A 
or Plan B as though you’d never used the beta at all. Once you’re 
sure everything is present and functional, you can erase your High 
Sierra beta volume. 

Note that if you used SuperDuper's sandbox feature to install the 
High Sierra beta on an external drive while keeping your user data 
(and perhaps your apps) on your Sierra volume, you can still upgrade 
your Sierra volume to High Sierra (again, using Plan A or Plan B). 
Doing so will break the sandbox—not that it’s likely to matter much. 
To learn how to handle this situation, see Upgrading from a 
SuperDuper Sandbox. 

Plan A: In-place Upgrade
 

As has been true since Snow Leopard, the High Sierra installer offers 
a single upgrade method that attempts to make the transition simple 
by leaving almost all your files, apps, and settings in place. You run the 
installer as you would any other app, and it replaces all the compo-
nents of your old macOS installation with their High Sierra 
equivalents, while deleting those that are obsolete—just as the App 
Store app does when it installs minor updates. 
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The High Sierra installer even helps you avoid many common incom-
patibilities. It contains a list of software known to conflict with the new 
operating system, and when you run the installer, as long as you have 
an active internet connection, it even checks for additions to the list. 
Software that’s on the list is moved safely aside into an Incompatible 
Software folder. 

Note: The installer can’t know about every possible software conflict 
and thus disable all software that’s incompatible with High Sierra—it 
disables only software that loads automatically on startup and that 
runs in the background, such as drivers and other kernel extensions. 
Ordinary apps are never moved aside, even if they can’t possibly run 
under High Sierra. 

In addition, some older software whose design is incompatible with 
High Sierra is left in place but rendered inert by the design of the 
operating system itself. This includes certain status menus, drivers, 
and other background processes. Still other incompatible items, such 
as older Apple Mail plug-ins, are disabled automatically when you first 
run the software that uses them. 

As long as you have a complete backup, you have little to fear from an 
in-place upgrade to High Sierra, and it’s entirely reasonable for Apple 
to have made it the default—indeed, the only official—option. 

However, I must reiterate that as good as the installer is, there are no 
guarantees. Something could still go wrong before, during, or after the 
upgrade. It’s also possible that, due to an error or design flaw in the 
installer, important files could be deleted. These are among the rea-
sons to entertain the possibility of following the clean install procedure 
that I describe next. 

Plan B: Clean Install
 

Whether or not you trust the installer (and High Sierra itself) to 
protect you from software incompatibilities, you might consider 
making a fresh start, erasing your entire disk and installing a clean, 
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pristine copy of High Sierra. This process requires a few extra clicks 
and a bit more time, but it’s not hard to perform—you merely have to 
start up from another volume (which could be your bootable duplicate) 
to erase your previous system, run the installer, and restore your 
personal files. 

The main reason to prefer a clean install over an in-place upgrade is 
that erasing your disk wipes out any hidden directory corruption, file 
system problems, and other disk gremlins that may cause problems. As 
a bonus, your entire disk is automatically defragmented, because the 
new files from your High Sierra installation and your backup are 
written to it in contiguous chunks. This can, in some situations, im-
prove disk performance (though only for hard disks, not for SSDs). 

If a clean install did nothing but erase your disk and install High 
Sierra, then all your preferences, network settings, user-installed 
software, and files would be gone, and you’d have to either restore 
them from a backup or recreate them from scratch: not fun. But as in 
other recent versions of macOS, the High Sierra installer offers an 
optional File Transfer feature—available only when you install onto a 
blank volume—that makes the process easy. As soon as the installation 
completes, Setup Assistant should run automatically and offer to 
migrate all your apps and personal files from another volume. Since 
you’ve made a bootable backup onto another disk, the installer can 
take all of your personal data from that disk and copy it to the analo-
gous location on the High Sierra volume. 

When copying your old data, you can be somewhat selective—copy 
only the contents of your home folder, say, or your third-party apps, or 
any of various other combinations—but you can’t select individual files 
or folders to migrate (or skip). If you select every possible category of 
data (the default ), Setup Assistant dutifully copies virtually everything 
from your backup to your startup volume (while moving aside any 
software it identifies as incompatible, just as occurs in an in-place 
upgrade). Almost to a file, the results should be identical to what you’d 
get by performing an in-place upgrade! (There are some tiny differ-
ences, such as certain cache and log files, but almost certainly nothing 
you’d ever notice if you didn’t scrutinize every last file on your disk.) 
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The thing is, I recommend that you do copy all your old data, because 
otherwise you’re likely to be left without something you need and 
expect. Therefore, since the net result is the same with the in-place 
upgrade method and a clean install, I now recommend the latter only 
in the following situations: 

•	 You want the benefits of a freshly optimized hard disk—or your disk 
(or SSD) has errors that neither Disk Utility nor third-party utilities 
can repair. 

•	 You want to be selective about which folders and files you let Setup 
Assistant copy (to reduce the clutter on your startup volume, for 
example, or to have a cleaner setup for testing purposes), and you’re 
willing to manually copy other files you may need after the fact. 

A Cleaner Clean Install? 
People occasionally tell me they want to do a completely clean 
install—with little or no automated migration of old apps and data—in 
order to make a fresh, cruft-free start with a new version of macOS. 
They’re worried that migration may transplant old problems to their 
new system and feel better about rebuilding everything manually. 

You are, of course, welcome to skip the migration step after a clean 
install, but reinstalling all your software from scratch, entering all 
your license codes, resetting your preferences, and updating all your 
data will be a big, tedious, and time-consuming project. I say more 
about this later, in The Nuke and Pave Option—but fair warning: I 
don’t recommend it. 

•	 You’re installing High Sierra onto a Mac that you just purchased, 
and you want to erase the drive and start fresh with High Sierra. 
You’ll transfer your data from your old Mac or Windows PC during 
the installation process. 

•	 You attempted an in-place upgrade and it failed, or it left your Mac 
in an unusable state. 

•	 You’re paranoid and you wouldn’t trust an in-place upgrade no 
matter what assurances I give you! 
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Double backup warning! I want to remind you that Plan B really 
will destroy all the data on your disk (or partition) prior to installing a 
fresh copy of High Sierra. If anything were to go wrong with your 
bootable duplicate, you would be unhappy, and you’d be even more 
unhappy if you didn’t also have some other backup. So check your 
backups! 

Pick a Plan
 

To summarize, I believe Plan A is best for most people. Let Apple’s 
installer do its thing. You’ll already have a bootable duplicate (because, 
remember, I insist on it!), so the worst thing that could happen is you 
lose an hour or so of your time and have to start over with Plan B’s 
clean install. The overwhelming probability is that everything will be 
just fine, however, if you go with the flow. 

With any plan—even with an in-place upgrade—questions, choices, and 
issues may arise. I’ll explain how to deal with all of them as we go. 

Things You Need Not Do 
I’ve received inquiries as to whether you should perform certain other 
procedures before upgrading. In all these cases, my advice is not to 
bother: they won’t hurt, but they’re also entirely unnecessary and 
won’t help, either. Things you should not worry about before upgrad-
ing to High Sierra include: 

✦ Deauthorizing your computer in iTunes 

✦ Repairing permissions (using old versions of Disk Utility) 

✦ Starting in Safe Mode (by holding down the Shift key) 

✦ Removing all login items 
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Make Final Preparations 
Now that you know which basic installation technique you’re going to 
use, you’re nearly ready to proceed. Your next major step (which could 
take hours, or even longer) is to obtain the High Sierra installer; then 
I’ll recommend a few other quick, last-minute tasks before you dive in. 

Turn Off Anti-malware Software
 

In general, anti-malware software doesn’t interfere with purchases 
and upgrades from the App Store. However, when Apple released 
Mountain Lion, users reported that the Ad Banner Filter in Intego’s 
VirusBarrier software sometimes interfered with the process of down-
loading the installer. Something similar could happen again, and other 
anti-malware apps could also conceivably prevent High Sierra from 
downloading properly. So, the easiest course of action is to turn off any 
anti-malware software you may have until you have downloaded High 
Sierra successfully, and then turn it back on. 

Obtain the Installer
 

Depending on your situation, obtaining the High Sierra installer may 
be a trivial matter of a few clicks, or it may be an involved ordeal. 

Download on the Destination Mac 
If, in your App Store Preferences (see Handle Software Updates), the 
“Download newly available updates in the background” box is checked, 
the High Sierra installer may already have downloaded without any 
further intervention. Otherwise, if you have an internet connection 
that can handle a 5 GB download, obtaining High Sierra is just like 
downloading any other app: 

1.	 Click the App Store icon in your Dock and locate macOS 10.13 High 
Sierra (or click this link to go straight to it). 
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2. Click Download (or Install, if there’s no Download button). 

3. If prompted, enter your Apple ID and password, and click Sign In. 

The High Sierra installer downloads to your /Applications folder—a 
process that could take anywhere from minutes to days, depending on 
the bandwidth of your broadband connection. 

Estimating Your Download Time 
For an estimate of your download time, use a speed test website,
 
such as Speedtest.net, to see the effective download bandwidth of
 
your internet connection. Then visit a site like Download Time and 

enter 5 GB (the approximate size of the High Sierra download) and 

your bandwidth to find out how long your download should take.
 

After it downloads, the installer launches automatically. 

But we’re not ready to install High Sierra quite yet, so choose Install 
macOS High Sierra > Quit Install macOS High Sierra (if you didn’t 
already do so after an automatic download) to quit the installer for the 
time being; we’ll return shortly! 

The App Store and Multiple Macs 
If you have more than one Mac—each signed in to the App Store with 
the same Apple ID—then once you download High Sierra on one, it 
will show up in the Purchased view on the others too. 

If you have bandwidth (and time) to spare, you can click Install on
 

each Mac to download the High Sierra installer. (If your Macs use
 

different Apple IDs in the App Store, you can choose Store > Sign
 

Out, choose Store > Sign In, enter the other Apple ID, re-download 

High Sierra, and then repeat the procedure to sign in under the
 

original account.)
 

But why go to that bother? It’s faster and easier to copy the installer 
from /Applications on the first Mac to the others using the Mac’s 
built-in File Sharing feature (hint: look in System Preferences > 
Sharing) or another method of your choice. Or, you may want to 
Make a Bootable High Sierra Installer Volume. 

50 

http://beta.speedtest.net/
http://www.download-time.com


         
             

           
            

          
         

       
       

          
    

          
  

   
            
             

           
              

              

             
  

         
    

       

          
 

         
           

     

If the destination Mac doesn’t have sufficient internet bandwidth, 
consider taking it to a library, coffee shop, friend’s house, the office, or 
somewhere else where you can use a higher-speed connection. If you 
take your Mac to a nearby Apple Store and download High Sierra while 
connected to the store’s Wi-Fi network, the download will be ultra-fast, 
because it will come from a server within the store. 

Tip: As long as you have a nice, high-speed connection at your 
disposal, I suggest doing the whole High Sierra installation, including 
the steps in Perform Post-installation Tasks, so you’ll be able to 
download any software updates you may need. 

If your Mac isn’t portable enough to make that feasible, however, 
there’s another option… 

Download on Another Mac 
You need to get the High Sierra installer onto your Mac somehow, but 
you need not download it from the App Store directly onto the Mac 
where you’ll install it. You can download the High Sierra installer on 
another Mac, and then copy the installer to your Mac over a network or 
by way of a USB thumb drive, a portable hard drive, or some other 
media. 

Although there are many ways to do this, the basic steps you’d want to 
follow are these: 

1.	 On the other Mac—the one where you’ll download the installer— 
open the App Store app. 

2.	 Download High Sierra, as described in the previous topic. 

3.	 Copy the installer from /Applications onto the external media of 
your choice. 

Note: Instead of (or in addition to) copying the installer, you could 

follow the steps in the sidebar Make a Bootable High Sierra Installer
 

Volume to create a bootable copy.
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Copy the Installer to a Safe Place
 

Unlike most software that you download from the App Store, what 
shows up in the /Applications folder after you download High Sierra is 
an installer (an application called Install macOS High Sierra); you 
must run the installer to put all the necessary pieces in place. During 
this process, something surprising happens: the installer is deleted! 
That’s right—once High Sierra is up and running, if you look 
in /Applications, the installer will be gone. 

I presume the reason for this is that once High Sierra is installed, 
Apple wants to give you back the 5 GB or so of disk space the installer 
was taking up, since you likely won’t need the installer in the future 
(and can download it again if you do). But what if you want to install 
High Sierra on multiple Macs—or reinstall it later on the same Mac— 
without having to download that huge installer again? I’ll tell you 
what: you’d better put that installer in a safe place before you run it! 

Now, before going any further, I should add some nuance to the “High 
Sierra installer deletes itself” concept. The installer deletes itself only 
when both of the following are true: 

• The installer is in /Applications on your startup volume. 

• You do an in-place upgrade of your startup volume. 

If you put the installer anywhere else—your Desktop, ~/Downloads, or 
wherever—it won’t be deleted after it runs. Even so, because that big 
file is valuable, I urge you to make a copy just in case the unexpected 
should happen. 

So, before you do anything else, you should either Command-drag the 
installer to move it from /Applications to another location (so it won’t 
be deleted automatically, no matter what), or Option-drag the installer 
to copy it to another location—preferably another volume—so if it is 
deleted, you’ll have a spare. Or, create a bootable installation volume, 
as I describe next. 
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Make a Bootable High Sierra Installer Volume 
The High Sierra installer doesn’t include or require boot media. But 
you might want to have a copy of the installer on a bootable disk as a 
backup, to simplify installing High Sierra on multiple Macs, to install 
High Sierra on a Mac without Snow Leopard or later, or for other 
reasons. 

The easy way to create this sort of disk is to use an app that does all 
the work with a few clicks—all you’ll need is a blank USB thumb 
drive, SD card, external hard drive, or other storage device with a 
capacity of at least 8 GB. Two apps that can do this, both free, are 
Install Disk Creator and DiskMaker X. 

The other option is a command-line tool called createinstallmedia 
that is buried inside the High Sierra installer (and thus is a method 
that Apple officially sanctions). Using this tool requires mucking 
around in Terminal—and it won’t work in Snow Leopard—but it 
requires no help from third-party apps. 

Roman Loyola explains how to use both approaches in his Macworld 
article How to create a bootable macOS High Sierra installer drive. 

Update Your Duplicate (Again)
 

Earlier in this book, I instructed you to make a bootable duplicate of 
your startup disk and then—after performing some cleanup tasks—to 
update that duplicate so it reflects the current state of your disk. If you 
did that just minutes ago—and your bootable duplicate includes the 
High Sierra installer file located outside of the /Applications folder— 
then you can move along to the next step. Otherwise, I suggest 
updating your duplicate one last time before running the installer. 

Turn Off (Yes, Off) Automatic 
Duplicates 

Picture this: shortly after you upgrade to High Sierra, your backup 
software (which is still installed, natch) runs at its scheduled time, 
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overwriting your bootable duplicate with a copy of your High Sierra 
installation. And then, an hour or two later, you discover that High 
Sierra has a major problem that requires you to go back to your previ-
ous version of macOS. But oops! The backup of your older system is 
already gone. 

So, although you should certainly continue updating your duplicate 
after High Sierra is installed, either do so using a new backup drive or 
wait a few days or so to make sure everything is working well enough 
under High Sierra that you are unlikely to go back to your old system. 
Then, and only then, turn automatic duplicates back on. 

Make a Copy of This Book
 

You’ll want to refer to this book while you perform your installation, 
especially if something goes wrong during the process. If you are 
reading on the Mac where you’ll be installing High Sierra, if possible, 
you should either copy it to another computer, iPhone, iPad, or other 
mobile ebook-reading device, or print portions of it. 

For tips on transferring this book to a mobile device, read our Device 
Advice page (hint: popular methods include Dropbox and downloading 
directly to the mobile device from your Take Control account). To 
download a copy of the book in a different file format, click the link in 
Ebook Extras. 

If you print to paper, you can limit the printout to just these chapters 
(as appropriate to your situation): “Upgrade Using Plan A: In-place 
Upgrade,” “Upgrade Using Plan B: Clean Install,” “Perform Post-
installation Tasks,” and “Troubleshoot Upgrade Problems.” 
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Upgrade Using Plan A: 
In-place Upgrade 

Now that you’ve gone through all the preliminary steps, it’s time to 
begin the upgrade. For most people, Plan A—essentially letting the 
installer do what it wants to do—is the logical choice. And remember, 
if it doesn’t work out for any reason, you can always move on later to 
Upgrade Using Plan B: Clean Install. Nevertheless, because you may 
encounter some questions or confusion during the process, I detail 
exactly what steps to take from start to finish. 

Warning! If you installed an early beta version of High Sierra on a 
Mac with a Fusion drive and let the installer convert your drive to 
APFS, you must erase and reformat the drive, and reinstall Sierra 
from a backup, before proceeding. See Learn about APFS for details. 

Start the Installer
 

Unlike installers of old, the High Sierra installer requires no separate 
startup disc; you simply run an app and it does its thing. However, if 
you haven’t already done so: 

•	 If you are installing onto a laptop, connect its AC adapter to a power 
source. (If you forget to do this, the installer will prompt you.) 

•	 Quit all open apps. (The installer attempts to do this for you—and 
prompts you if it can’t—but you might as well take care of this 
beforehand.) 

Note: Not to belabor the point, but now that we’re two clicks away
 

from installing High Sierra, be sure you have an up-to-date bootable
 

duplicate of your startup disk. If not, go no further until you’ve read 

and followed the instructions in Back Up Your Disk.
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To begin the process, double-click the Install macOS High Sierra icon 
in your /Applications folder or wherever else you put it. A window 
appears with just one button: Continue. Click it! 

The Software License Agreement appears next; click Agree, and then 
click Agree again in the confirmation dialog to proceed. 

Select a Destination
 

The next screen asks you confirm which volume you want to install 
High Sierra onto. In most cases, it displays its best guess—typically 
your startup volume (Figure 6)—but in some situations you may see 
multiple disks here, in which case you should select the one you want. 
To install High Sierra onto a volume that’s not shown, click Show All 
Disks to display all available options and then make your selection. 

Figure 6: If the installer’s best guess as to your desired destination 
isn’t right and the one you want isn’t visible, click Show All Disks. 
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If the installer can’t use a volume as the destination for any reason, 
that volume is dimmed; click it for an explanation. Note that you can’t 
install High Sierra onto: 

•	 A disk that uses a partition map scheme other than GUID Partition 
Table (see Prepare Your External Drive) 

•	 A volume formatted using anything other than Mac OS Extended 
(Journaled) or APFS, with or without case-sensitivity or encryption; 
you’re prompted to reformat it using Disk Utility 

•	 A volume containing an installation of 10.5 Leopard or earlier 

Note: If you see an “Unsupported partition structure” error message, 
skip way ahead to Can’t Select Installation Volume…. 

With your desired destination volume selected, click Continue or 
Install (the wording varies depending on your setup). 

Next, you’re prompted to enter your administrator credentials (in 
order to add a helper app); do so and click Add Helper. 

The installer begins copying files. The copy process may take only a 
few moments or it may take several minutes, but when it finishes, the 
installer tells you that it will restart your computer automatically in 
30 seconds; you can also click Restart to restart immediately. If any 
applications are still open and the installer is unable to close them 
automatically (for example, if there are unsaved changes you must 
respond to), the installer displays a prompt asking you to click Close 
Other Applications. 

Note: If you are installing High Sierra onto a disk that’s encrypted 
with FileVault, then immediately after the installer restarts your Mac, 
you may be prompted to enter your password to unlock the disk. 
There may also be a longer-than-expected delay before the installa-
tion proceeds; be patient. 
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Bake Some Cookies
 

Depending on a number of variables, including the speed of your 
computer and the size of your hard disk or SSD, installation may take 
less than a half hour or as long as several hours. But in general, it will 
be longer than the process of installing earlier versions of macOS, 
because of the extra time required to convert your volume to APFS. 
Apart from the steps you’ve already performed, the process normally 
requires no intervention until the very end. While the remainder of the 
installation proceeds, you won’t be able to use your Mac for anything 
else, so now’s a good time to bake some cookies, call your mom, or go 
for a jog—you have a bit of time to kill. 

Note: If you insist on watching the installer’s progress bar gradually 
make its way across the screen, beware: its time estimates (“About 
43 minutes,” “Less than a minute,” etc.) are notoriously inaccurate, 
especially near the beginning and end of the process. And remember, 
a watched installer never boils. 

As the installer progresses, your Mac will restart one or more times, 
and it may make some unusual sounds (like a long beep), but the 
startup chime may not play. At the end of the installation, you’ll 
continue with several additional configuration steps. 

Finish Setup Assistant
 

What happens next depends on how your Mac was previously set up: 

•	 If you had Automatic Login turned on previously, High Sierra logs 
you in automatically. 

•	 If Automatic Login was off, your entire screen becomes a login 
screen. Select (or enter) your username if necessary, enter your 
password, and press Return to log in. This initial login process may 
take longer than usual, so be prepared to wait a few minutes before 
the login screen disappears. 
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The first time you use High Sierra, macOS Setup Assistant runs, 
although you won’t see that name—it looks like a continuation of the 
installer. With an in-place upgrade, this program has little to do 
compared with a clean install—most of your settings are already in 
place. 

Depending on which version of macOS you’re upgrading from and 
your previous settings, you may see one or more additional screens: 

•	 Enable Siri: This screen has a single checkbox, Enable Siri on This 
Mac, which is selected by default. Leave it selected to enable Siri 
voice control after High Sierra is installed, or deselect it to disable 
Siri. (Either way, you can always enable or disable Siri later—go to 
System Preferences > Siri once High Sierra is up and running.) 

•	 Sign in with Your Apple ID: Even if you were signed in to 
iCloud in your previous version of macOS, this screen may prompt 
you to sign in again. Depending on the circumstances, you may be 
asked only for your password, or for both your Apple ID and your 
password. If you have to enter both, be sure you’re using the right 
Apple ID: 

‣	 To use one Apple ID for everything, leave Sign in with Your 
Apple ID selected, enter your Apple ID and password, and click 
Continue. 

‣	 To use one Apple ID for iCloud and a different one for iTunes 
purchases, click the “Use a Separate Apple ID for iCloud and 
iTunes” link. Enter the Apple ID and password you want to use 
for iCloud first. Click Continue, fill in the Apple ID and password 
you want to use for iTunes purchases, and click Continue again. 
(The option to sign in with separate accounts appears only under 
certain conditions.) 

‣	 To make a new Apple ID, click Create New Apple ID and follow 
the prompts. 

‣	 If you don’t want to enter an Apple ID—and are willing to forgo 
all iCloud features for the present—select Don’t Sign In (your 
wording may be slightly different), click Continue, and then click 
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Skip again to confirm. (You can enter this information later, in 
System Preferences > iCloud.) 

•	 Verify Your Identity: If you’ve enabled Apple’s Two-Step Verifi-
cation for your Apple ID, an extra screen may ask you to choose an 
iOS device or SMS number to receive a numeric verification code. 
Make your selection and enter the code to continue. (In my tests, 
this screen did not appear during in-place upgrades when Apple’s 
newer Two-Factor Authentication was enabled.) 

•	 Find My Mac: If you hadn’t previously enabled iCloud’s Find My 
Mac (and Location Services, on which it depends), a dialog appears 
asking if you’d like to do so. Click Allow to enable Find My Mac, Not 
Now to do nothing (you can change your settings later in System 
Preferences > iCloud), or About Find My Mac to learn more. 

•	 Terms and Conditions: Setup Assistant wants to be sure that 
you’ve consented to a bunch of additional legalese, so it may invite 
you to read, study, and agree to as many as three different 
statements: “macOS Software License Agreement,” “Privacy Policy,” 
and “Game Center Terms and Conditions.” Handle these however 
you want; I’ve found that my lawyer enjoys chatting with me about 
each paragraph of such agreements in detail (at his usual hourly 
rates). 

•	 All Your Files in iCloud: If you’ve already signed in to your 
iCloud account by this point in the installation but did not 
previously have iCloud configured to sync your Documents and 
Desktop folders, High Sierra may ask if you want it to store all the 
files from your Documents and Desktop folders in iCloud Drive 
(and, from there, to your other Macs). 

This option, when it appears, is selected by default, but I recom-
mend waiting until after you install High Sierra—and even then, 
thinking carefully about whether you want to upload all that stuff to 
the cloud. So my suggestion is to deselect “Store files from Docu-
ments and Desktop in iCloud Drive” for now, and if you decide later 
that you want that feature, you can turn it on then. To do so, go to 
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System Preferences > iCloud, click the Options button next to
 
iCloud Drive, and then select Desktop & Documents Folders.
 

•	 Diagnostics & Usage: High Sierra can automatically send 
diagnostic and usage data to Apple and/or third-party developers to 
help them track down the causes of crashes and other bugs you may 
encounter. This information is anonymous and doesn’t contain 
personal information. 

If you want to send this troubleshooting data in the event that a 
problem occurs, select Send Diagnostics & Usage Data to Apple. 
With that selected, you may also select Share Crash Data with App 
Developers. (You can’t share crash data with app developers unless 
you also share diagnostic data with Apple.) 

•	 iCloud Drive: iCloud Drive makes all your iCloud files available to 
any app on your Macs (running Yosemite or later) and iOS devices 
(running iOS 8 or later). If you see an iCloud Drive screen during 
setup (which should be the case only if you’re upgrading from 
Mavericks or earlier), it’s asking whether you want to switch to this 
way of accessing iCloud documents: 

‣	 Answer Not Now if you still need to access iCloud documents 
using older operating systems on any of your Macs or iOS de-
vices. If you answer Not Now, you can turn it on later by going to 
System Preferences > iCloud and selecting iCloud Drive. 

‣	 Answer Upgrade to iCloud Drive if all your devices are using (or 
are about to be updated to) Yosemite or later, or iOS 8 or later. 

•	 Incompatible Software: In rare cases, you may see a screen in 
Setup Assistant labeled Incompatible Software (Figure 7). If so, 
glance at it and click Continue; I explain what to do about this 
software a bit later, in Review the Incompatible Software Folder. 
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Figure 7: This screen lists any incompatible software the installer 
moved aside. Check with the developers for updated versions. 
(These old examples are from Sierra—so far, none of the software I 
use regularly has triggered this warning when installing High Sierra.) 

Once you’re through with all that, Setup Assistant may display a 
“Setting Up Your Mac” screen briefly. Then it quits automatically and 
displays your High Sierra Desktop. 

Tip: Not sure if you’ve successfully upgraded since you missed the 
end of the process? Choose Apple  > About This Mac. If the window 
says 10.13 at the top under “macOS,” you’re running High Sierra! 

Check for Proper Operation
 

In all probability, your upgrade will have gone smoothly, and every-
thing will now work more or less the way you expect. However, even if 
everything looks fine, don’t declare upgrade victory until you Perform 
Post-installation Tasks, including dealing with any alerts and queries 
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that pop up shortly after installation, checking for software updates, 
and configuring a few new options in System Preferences. 

If anything did go amiss, or if you later discover problems that aren’t 
solved by following the advice in Troubleshoot Upgrade Problems, you 
can fall back to Upgrade Using Plan B: Clean Install. 

Upgrading from a SuperDuper Sandbox 
SuperDuper, one of the backup apps that I recommend for making 
bootable duplicates, has a feature called Sandbox that’s ideal for 
testing new versions of macOS. When you create a Sandbox on an 
external drive, it looks and acts like a clone of your main disk, except 
that the /Users folder (and, optionally, the /Applications folder) 
aren’t copied from the main disk—instead, the Sandbox contains links 
to those folders on your main disk. That way, changes you make to 
your documents or third-party apps while booted from the Sandbox 
appear when you reboot from your main disk, and vice versa. 

If you beta-tested High Sierra, you may have used a SuperDuper 
Sandbox to do so—that is, you may have installed the High Sierra 
beta on your Sandbox drive to keep your main disk safe while keep-
ing all your documents in sync. But now that you’re upgrading to 
High Sierra for real, what are the consequences for your Sandbox? 

✦ Upgrading your Sandbox: You can install the final release of High 
Sierra on your Sandbox drive if you’re not quite ready to make the 
leap on your main disk yet. But when you’re ready, you should 
separately upgrade your main disk to High Sierra—don’t just copy 
your Sandbox back onto your main disk. Then you can erase your 
Sandbox and use the drive for something else. 

✦ Upgrading your main disk: If you install High Sierra on your 
main disk, your Sandbox will most likely break. That may be irrele-
vant—after all, you have a separate bootable duplicate too (right?), 
so you may be finished with the Sandbox. However, if you want to 
install High Sierra on your main disk and update your Sandbox so 
it’s also running High Sierra, you can. After upgrading your main 
disk, use SuperDuper’s Smart Update feature to copy only new and 
changed files to your Sandbox drive. 
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Upgrade Using Plan B: 
Clean Install 

If you prefer a cleaner installation of High Sierra than what an in-place 
upgrade provides—specifically, one that gets rid of any disk errors and 
gives you a chance to weed out some types of user-created data—Plan 
B is what you should follow instead of Plan A. It’s also the right choice 
if you tried Plan A and encountered problems. 

Much of Plan B is just like Plan A, so I refer to earlier discussions for 
some details. The differences come at the beginning (erasing your disk 
manually) and the end (using Setup Assistant to configure numerous 
settings and, optionally, transfer data from your bootable duplicate). 

Start Up from Your Bootable Duplicate 

Unlike Plan A’s in-place upgrade, Plan B requires a bootable duplicate 
of a Snow Leopard, Lion, Mountain Lion, Mavericks, Yosemite, El 
Capitan, or Sierra volume, which accomplishes three things: 

•	 You must erase the destination volume first. But you can’t erase the 
volume your Mac is currently running from, so you must start up 
from another volume. 

•	 You’ll need access to the High Sierra installer too, of course, so it’ll 
be easiest if the volume you start up from contains the installer. 

•	 Once High Sierra is installed, you’ll need your bootable duplicate 
(the one you created in Back Up Your Disk, remember?) connected 
in order to transfer your old data. 

To start up from your duplicate: 

1.	 Make sure the disk containing your duplicate is physically connect-
ed to your Mac (via Thunderbolt, USB, FireWire, or eSATA). 
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2.	 Choose Apple  > Restart. 

3.	 Press and hold the Option key until a list of available startup 
volumes appears on screen. 

4.	 Use the arrow keys to select your duplicate, and then press Return 
to boot from it. 

Now that you’ve booted from what is about to be your old copy of 
macOS, you can erase your main disk and install High Sierra onto it. 

Erase Your Disk
 

Having started up from your duplicate, to erase your destination 
volume in preparation for High Sierra, follow these steps: 

1.	 Open Disk Utility (on your duplicate, in /Applications/Utilities). 

2.	 In the list on the left, select the volume you want to erase. Volume 
names (there may be one or more per disk) are shown indented 
under the disk name, so be sure to select one of the indented icons. 

Choose carefully! Triple-check to be sure that the volume you’re 
erasing is the one where you want to install High Sierra, and that it’s 
the one you’ve backed up on your bootable duplicate! 

3.	 On the toolbar, click the Erase button. 

4.	 Make sure Format is set to Mac OS Extended (Journaled), and click 
Erase. 

Note: You may recall that High Sierra reformats volumes to use APFS 
(see Learn about APFS), but since older versions of Disk Utility don’t 
offer that format, it’s fine to use Mac OS Extended and let the in-
staller do the conversion afterward. 

5.	 If you see a confirmation dialog, click Erase again. Disk Utility 
erases the disk, which normally takes just a few seconds. Click Done 
if prompted to do so when the Erase process is complete. 
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6. Choose Disk Utility > Quit Disk Utility.
 

You’re now ready to install High Sierra on the empty volume.
 

Run the Installer
 

To proceed, make sure you’ve quit all running apps and then double-
click the Install macOS High Sierra icon in your /Applications folder 
or wherever else you put it. A window appears with one button: Con-
tinue. Click it! 

The next few steps are identical to those for an in-place upgrade: 

1.	 The Software License Agreement appears next; click Agree, and 
then click Agree again in the confirmation dialog to proceed. 

2.	 Now select your destination. If needed, click Show All Disks to 
display all available options and click the one you want to use. 

3.	 With your desired destination volume selected, click Install. 

4.	 Next, enter your administrator credentials and click Add Helper. 

The installer begins copying files, a process that typically takes just a 
few moments, but may take longer. Then, depending on your configu-
ration, it may restart automatically or it may ask you to click a Restart 
button. After the restart, the main portion of the installation process 
occurs. 

Note: If you are installing High Sierra onto a disk that’s encrypted,
 
then immediately after the installer restarts your Mac, you may be
 

prompted to enter your password to unlock the disk.
 

During the installation, you may want to Bake Some Cookies. As the 
installer progresses, your Mac will restart one or more times, but the 
startup chime may not play. You’ll know the process has finished when 
the Welcome screen appears. That’s part of Setup Assistant, to which 
we now turn our attention. 
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Note: If the Welcome screen never appears or your Mac doesn’t 
restart at all under High Sierra, find out what to do in Mac Won’t 
Start Up under High Sierra…. 

Use Setup Assistant
 

Setup Assistant is a program that looks like a continuation of the High 
Sierra installer. It runs automatically after High Sierra restarts at the 
end of the installation process, and serves several purposes (some of 
which may not apply to you): 

•	 If applicable, it offers to transfer files from another Mac or PC, 
another volume (which can be your bootable duplicate; see Transfer 
Your Old Data, next), or a Time Machine backup. 

•	 It enables you to select your preferred country or region, and key-
board layout. 

•	 It configures your Mac to connect to the internet using a wireless 
network, if applicable. 

•	 It sets up your Mac to use your Apple ID for iCloud, iTunes, and 
other services. 

•	 It sets up an initial user account (with administrator privileges) if 
you’re not transferring an account from a backup or other source. 

•	 It lets you set your time zone, and the current date and time. 

•	 It lets you pick a graphic (or, if you prefer, use your Mac’s built-in 
camera to take a snapshot) to associate with your user account. 

Your first task, on the Welcome screen, is to select a country or region 
and click Continue. You then see the Select Your Keyboard screen, 
which should be self-explanatory. 

Setup Assistant next looks for a network connection. You’ll see a screen 
called Select Your Wi-Fi Network. Select the network to which you 
want to connect and, if required, enter the password. Then click 
Continue. (If you connect to the internet some other way—or if you 
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have no internet connection—click Other Network Options and select 
the appropriate option.) 

Next is the Transfer Information to This Mac screen (Figure 8), which 
enables you to transfer files from your bootable duplicate (as I cover 
next). If you’re tempted to skip this step in order to have a completely 
clean copy of High Sierra, be sure to read the sidebar The Nuke and 
Pave Option. 

Figure 8: On this screen, you can begin the process of moving data 
from your bootable duplicate to your High Sierra volume. 

Transfer Your Old Data 
Setup Assistant includes “migration technology,” which is a fancy way 
of saying that it can copy important files from another computer or 
another volume in an intelligent way. We use it here to transfer the 
data from your bootable duplicate. (High Sierra includes a stand-alone 
app called Migration Assistant—found in /Applications/Utilities— 
but you probably won’t need to use it because Apple has integrated this 
tool’s capabilities into Setup Assistant.) 
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Note: Although you could choose not to transfer your information 
now and use Migration Assistant later, that may involve extra steps 
and hassle. In general, you’ll get better results with less effort by 
transferring your files right now. 

Other Setup Assistant Transfer Options 
Besides the method I describe ahead, Setup Assistant lets you
 

transfer your data from three other sources:
 

✦ Another Mac: This could be another Mac on your network, or one 
connected with a FireWire or Thunderbolt cable. (Newer Macs can 
also use a USB cable.) 

✦ A Windows PC: High Sierra can migrate an account from a PC on 
your local network running Windows. 

✦ Time Machine: You can also restore files from a Time Machine 
backup stored on a local disk, network volume, or Time Capsule. 

I don’t cover these methods in this book. A Time Machine backup 
may not contain all your important files, so I don’t recommend it in 
this situation, but it’s better than nothing. And the first two options 
are ones you might encounter if you’re “upgrading” to High Sierra by 
buying a new Mac. To learn about any of these options, see my 
TidBITS article How to Migrate to a New Mac. 

To transfer your old data to your new installation, work your way 
through the following screens: 

Transfer Information to This Mac 
Begin by selecting “From a Mac, Time Machine backup, or startup 
disk.” Click Continue. Now, select your bootable duplicate and click 
Continue. 

Note: If your source disk is encrypted with FileVault, the Continue
 

button becomes Unlock. Click it and enter the disk’s password.
 

Select the Information to Transfer 
Now, select the kinds of data you want to transfer. The screen shows 
the size of each item, and the total size of the selected items, along with 
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available space on your High Sierra volume, updates automatically as 
you change your selections. (It may take a few minutes for the installer 
to initially display and calculate the size of each option.) 

If the volume you’re transferring from has only one user account, you 
may see only three checkboxes, all selected by default: Applications, 
Documents & Data (with an accompanying Edit button), and Comput-
er & Network Settings. If the volume has more than one user account, 
you’ll see a scrolling list that contains numerous items—again, all 
selected by default: Applications, each user account listed by name, an 
“Other files and folders” entry, and Computer & Network Settings. 

Here’s an explanation of each option, and my recommendations: 

•	 Applications: This option transfers the contents of your 
previous /Applications folder (and its subfolders, such as Utilities), 
skipping any applications for which the High Sierra installer has 
already loaded newer versions (Safari, Mail, and so on). Because 
you may find it tedious to reinstall your applications, leave this 
option selected, as it is by default. 

Note: If you select Applications, the High Sierra installer also copies 
the contents of /Library on your previous system. This is extremely 
good, because that folder contains many support files without which 
some apps wouldn’t run. As with /Applications, though, the installer 
won’t copy any older files over newer versions it has just installed. 

•	 Documents & Data: If you have just one user account, you’ll see 
a checkbox labeled Documents & Data—this refers to the data in 
your user account. Click Edit to view its contents. In the dialog that 
appears, you can deselect any top-level folder within the account, 
except for the Library folder. Along with the visible top-level folders 
is a folder called Other Data. Apple doesn’t specify what this in-
cludes and my tests to find out have been inconclusive, so I suggest 
leaving it selected just in case it contains anything you need. Finally, 
there’s a checkbox labeled “Other files and folders.” This option 
refers to any files or folders at the root level of your old volume as 
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well as anything in the /Users/Shared folder. I suggest leaving this 
checkbox selected. 

•	 User accounts: If you have more than one user account, each is 
shown at the top level of the list. 

This list may include “users” that don’t have a conventional user 
account or home folder on your Mac, but which your Mac considers 
to have an account of a sort—people with whom you’ve shared files 
using System Preferences > Sharing, for example, or special low-
level accounts added by software such as MacPorts or Cloak (the 
cloakproxy account). Some of these may display messages about 
having no home folder or having a home location that is no longer 
valid. You don’t have to worry about these messages; Setup As-
sistant is merely pointing out that these won’t create conventional 
user accounts, each with its own home folder. It’s best to leave such 
user accounts selected, even if they appear to contain no data. 

Transferring a user means copying the user’s entire home folder, if 
any (/Users/SomeUserName), to the High Sierra volume; once a user is 
transferred, the user can log in without having to set up an account 
again. You should transfer all the existing users unless you have 
accounts that are no longer in use. You can, if you like, deselect any 
individual (top-level) folders within a user’s home folder to skip 
copying those to your High Sierra volume. As for the unexplained 
Other Data folder (mentioned in the previous bullet point), the 
safest course is to leave it selected. 

If you don’t transfer at least one account, your screens later in these 
steps will be slightly different. Also, if you ever want to transfer any 
of these accounts, now is by far the best time to do so; copying files 
manually may cause you no end of grief and the Migration Assistant 
may not work as you’d hope. 

•	 Other files and folders: As in the single-user account setting 
described in the second bullet point, this option refers to any files or 
folders at the root level of your old volume as well as anything in 
the /Users/Shared folder. I suggest leaving this checkbox selected. 
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•	 Computer & Network Settings: This category sometimes has up 
to three sub-items that you can select. Computer includes certain 
system-wide settings, such as sharing preferences, energy saver 
settings, and parental controls. Printers refers to your printer 
settings. Network includes the settings in your Network preference 
pane. I suggest leaving Computer & Network Settings (and all sub-
items, if present) checked. 

After making your selections, click Continue. 

Transferring Your Information 
Setup Assistant copies the selected items to your new High Sierra 
volume—a process that may take just a few minutes or several hours, 
depending on how much data you are transferring. (And you should 
completely disregard any time estimates you see—as elsewhere in the 
installer, they’re wildly inaccurate.) 

Incompatible Software 
If Setup Assistant doesn’t notice any software conflicts with the files 
you’ve selected, you won’t see this screen. But if it does, this screen 
displays an Incompatible Software warning notice and the conflicting 
items are moved to an Incompatible Software folder at the top level of 
your startup volume or home folder. I say more about this in Review 
the Incompatible Software Folder. Click Continue to keep going. 

FileVault 
If FileVault was enabled on the volume you’re migrating data from, a 
screen appears to remind you that it’s not enabled automatically on 
your new volume—but that you can enable it manually. 

Migration Complete 
At the end of the migration process, a Migration Complete screen 
appears, stating that your data has been migrated and is ready to use. 
Click Quit to dismiss the window. At this point, your Mac should 
prompt you to log in, and then just a few questions remain. 
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Complete Setup Assistant 
The next steps in Setup Assistant are mostly self-explanatory. Depend-
ing on which version of macOS you’re upgrading from, what informa-
tion you transferred, and your previous settings, you may see one or 
more additional screens. (You’ll see even more screens if you’re per-
forming a clean installation of High Sierra without migrating any 
existing accounts—refer to The Nuke and Pave Option for an important 
recommendation.) 

Here are some of the screens you may encounter. (Most of them are 
identical to those described earlier in Finish Setup Assistant, so I 
describe them only briefly here.) After each one, click Continue to 
advance through the remaining screens: 

•	 Enable Siri: This screen has a single checkbox, Enable Siri on This 
Mac, which is selected by default. (Regardless of your choice here, 
you can enable or disable Siri later—go to System Preferences > Siri 
once High Sierra is up and running.) 

•	 Sign in with Your Apple ID: Depending on the circumstances, 
you may be asked only for your password, or for both your Apple ID 
and your password. In the latter case, enter the Apple ID you want 
to use for iCloud and iTunes, along with your password; or, if you 
prefer to use a different one for each, click Use a Separate Apple ID 
for iCloud and iTunes. 

•	 Verify Your Identity: If you’ve enabled Apple’s Two-factor 
Authentication or Two-step Verification for your Apple ID, an extra 
screen may ask you to perform a second verification step. 

•	 Find My Mac: If prompted to do so, click Allow to enable Find My 
Mac, Not Now to do nothing, or About Find My Mac to learn more. 

•	 Terms and Conditions: Yes, you already agreed to the High 
Sierra license, but this screen includes additional legalese, notably 
Apple’s Privacy Policy and Game Center Terms and Conditions. 

•	 All Your Files in iCloud: High Sierra may ask if you want it to 
store all the files from your Documents and Desktop folders in 
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iCloud Drive. I recommend that you deselect “Store files from 
Documents and Desktop in iCloud Drive” for now, and if you decide 
later that you want that feature, you can turn it on. To do so, go to 
System Preferences > iCloud, select the iCloud Drive checkbox if it 
is not already selected, click the Options button next to iCloud 
Drive, select Desktop & Documents Folders, and click Done. 

•	 iCloud Drive: If all your devices are using (or are about to be 
using) Mavericks or later or iOS 8 or later, select Upgrade to iCloud 
Drive. Otherwise select Not Now. 

•	 Diagnostics & Usage: Select one or both of these checkboxes to 
send just Apple or Apple and third-party developers data that could 
help them to fix crashes and other bugs. 

•	 Setting Up Your Mac: When you see this screen, you know Setup 
Assistant has stopped asking you questions. It’ll disappear on its 
own in a moment and you’ll be looking at your High Sierra Desktop. 

Whether Setup Assistant displays just one screen or many, High Sierra 
itself may display any number of dialogs and alerts the first time you 
use it, such as password prompts, software update messages, and 
requests to enable various features. To learn how to deal with these 
and other immediate concerns, see Perform Post-installation Tasks. 
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The Nuke and Pave Option 
Some people want to do a truly clean clean install of High Sierra— 
that is, install a pristine copy of macOS completely from scratch, with 
no migration of older apps and files. The technical term for such 
people is gluttons for punishment, because (having done this a few 
times myself) I can guarantee that it will involve many frustrating 
hours of tedious work. It’s virtually never necessary, and my profes-
sional opinion is that life is too short—you should avoid doing this. 

Nevertheless, if you insist on this approach, let me offer a few tips: 

✦ Follow everything in this chapter except the transfer part—when
 

asked, select Don’t Transfer Any Information Now.
 

✦	 Assuming you sign in with your Apple ID when Setup Assistant 
prompts you to, when you later get to the Create a Computer 
Account screen where you’re asked to create an initial administrator 
account, the checkbox “Allow my Apple ID to reset this password” 
is selected by default. I recommend deselecting this option (and 
instead making a note of your password in a secure place), because 
it creates additional security risks. 

✦ Besides the screens covered in Complete Setup Assistant, you may 
be asked to set up iCloud Keychain and select your time zone. 

✦	 Once High Sierra is running, you’ll have to reinstall all your apps. 
It’s pretty easy to do that for apps from the App Store. For every-
thing else, you’re on your own—and I hope you kept track of your 
license codes, because you’ll have to reenter them all! 

✦ You’ll have to reset most of your preferences from scratch. But… 

✦ If you use iCloud, the settings and data for apps such as Mail,
 
Contacts, and Calendar will restore themselves, as will your
 

keychain contents (assuming you have the relevant checkboxes 

selected in System Preferences > iCloud).
 

✦	 If you use Dropbox or similar cloud storage, you can log in and 
have all the files stored there sync back to your Mac—but be pre-
pared for a long wait. 

✦	 You may want to copy at least some files—such as your Photos or 
iTunes libraries—from a backup. Guard that backup carefully until 
you’re certain that you have everything you need from it. 
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Perform Post-installation 
Tasks 

If everything has gone as expected, your Mac is now successfully 
running High Sierra. (If things haven’t gone as expected, flip forward 
to Troubleshoot Upgrade Problems.) But there are still a few tasks left 
to do before you get to work—or play—with your new operating 
system. In this chapter I cover some important initial setup and 
configuration activities you should get out of the way right now. 

Respond to Immediate Questions
 

My test installations of High Sierra have used various combinations of 
starting points, configurations, and upgrade paths. In some cases, after 
installing, I saw a normal Desktop and nothing more. In other situa-
tions—especially when I upgraded older versions of macOS, had a lot 
of third-party software, or wasn’t previously logged in to iCloud—I was 
immediately confronted with a large stack of overlapping dialogs and 
notifications. 

Among the most common questions are requests for your user account 
password or Apple ID password. For example, certain apps may once 
again need an administrator’s authorization to make changes to your 
data, and various apps that use your Apple ID (including iTunes and 
iBooks) may need you to sign in again. 

Tip: Even if you’re not prompted, it’s a good idea to check System
 

Preferences > iCloud to make sure you’re signed in to iCloud (and 

with the correct Apple ID). Do the same in iTunes (Account > View
 

My Account) and the App Store (Store > View My Account).
 

In some situations, you may also see a notification like the one in 
Figure 9. This appears to mean that, in the process of syncing your 
accounts via iCloud with your other Macs, High Sierra found one or 
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more email accounts that were either missing from this Mac or had 
different settings. To add (or update) the accounts, click Continue; 
High Sierra then opens System Preferences > Internet Accounts, where 
you can verify all the settings. Or, click Not Now to leave your accounts 
as is for the time being. 

Figure 9: Sometimes email accounts are correctly configured 
but not turned on until you agree. 

Work your way through any such dialogs you see, even if they seem 
redundant. After that one-time process, most of them will not 
reappear. 

Handle Software Updates
 

The next thing you should do is to update macOS itself (and any other 
crucial Apple software) to the latest version. Sometimes Apple releases 
bug fixes and security updates almost immediately after a major 
upgrade, and if any such urgent updates are available, it’s in your best 
interest to install them right away. 

In High Sierra, as in every version of the Mac operating system since 
Mountain Lion, all updates to Apple software—including macOS itself, 
built-in software such as Safari and QuickTime, and optional purchas-
es such as Final Cut Pro and Pages—are delivered through the App 
Store app. And, of course, you can update all the third-party apps 
you’ve purchased from the App Store at the same time. 

In some cases, the App Store notifies you automatically of updates, 
but I recommend checking manually, shortly after your Mac starts up 
under High Sierra for the first time. You can open the App Store by 
clicking its Dock icon, double-clicking its icon in /Applications or in 
Launchpad, or choosing Apple  > App Store. Then click the Updates 
button on the toolbar. 
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Then, to update a single application, click the Update button next to 
it. (In some cases, Apple groups multiple software updates together; 
click the More link to see details on each one.) Or, to update all the 
listed apps at once, click Update All. The App Store downloads and 
installs the updates automatically. 

In addition to installing any updates, decide how you want the App 
Store to handle future updates. Your Mac can check for, download, 
and even install updates in the background. Some people turn off all 
aspects of automatic updates—perhaps because they never want to be 
interrupted with alerts about new software, dislike the idea of anything 
downloading behind their backs, or need to keep an eye on a band-
width cap. Others want all the new things right away without manual 
intervention and…ahem…have sufficiently robust backups that they 
can recover from any problems that may arise due to a buggy update. 

Follow these steps to configure software updates: 

1. Go to System Preferences > App Store (Figure 10). 

Figure 10: Configure automatic updates in the App Store pane. 
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2.	 Select or deselect (as you prefer) the Automatically Check for 
Updates checkbox to enable or disable automatic checking. If it’s 
selected, you can also select any or all of: 

‣	 Download Newly Available Updates in the Background, which 
not only notifies you of updates but downloads them for you so 
you can install them as soon as you’re ready (click Install to 
install immediately; click Later and choose Try in an Hour, Try 
Tonight, or Remind Me Tomorrow from the pop-up menu to 
“snooze” the reminder; or click the notification itself to open the 
App Store and see which updates are available) 

‣	 Install App Updates, which silently updates apps automatically 
after they’re downloaded (except those requiring a restart or 
other interaction) 

‣	 Install macOS Updates, which does the same as Install App 
Updates except for macOS itself—that is, macOS 10.13.x—and 
will presumably prompt you to restart your Mac 

‣	 Install System Data Files and Security Updates, which automat-
ically (without prompting you) installs these essential updates— 
but only after they’ve been available in the App Store for 3 days 

Note: Regardless of these settings, you can always check for updates 
manually at any time by clicking Check Now (which changes to Show 
Updates if updates have already been downloaded). 

3.	 If you’re signed in to the App Store, you can also check or uncheck 
Automatically Download Apps Purchased on Other Macs, which 
does exactly what it says. 

4.	 If you’ve previously felt that the App Store prompts you for your 
password too often, you can make some small adjustments to that 
behavior. At the bottom of the App Store pane are two pop-up 
menus under the heading Password Settings: 

‣	 Purchases and In-app Purchases: Choose when a password 
prompt appears—either Always Require (the default) or Require 
after 15 Minutes. 
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‣	 Free Downloads: Choose either Require Password (the default) 
or Save Password, which means you won’t be prompted after the 
first time you enter your password for a free download. 

Manual Updates of macOS 
All updates to macOS are available not only through the App Store 
but also on Apple’s website, so you can download them manually 
if you wish. This lets users decide whether to use a standard (or 
“delta”) updater, which requires the most recent previous release of 
macOS, or a “combo” updater, which can update any previous ver-
sion of the major system release (for example, 10.13.0 or 10.13.1) 
to the new version (say, 10.13.2). 

Review the Incompatible 
Software Folder 

If the High Sierra installer encounters any known incompatibilities, it 
moves the problematic software to an Incompatible Software folder 
and explains what it moved on one of the final screens of Setup As-
sistant. (After Setup Assistant quits, you can find the Incompatible 
Software folder at the top level of your startup disk, at the top level of 
your home folder, or even in both places, depending on the location of 
the software that was disabled.) 

This notice appears only for extensions and other low-level back-
ground software that would otherwise run automatically when you 
start up your Mac. As it says, the items in question are moved aside 
but not deleted. Whatever you do, don’t try to reenable this software 
manually! Instead, contact the developer and get a version that’s 
compatible with High Sierra, and then reinstall it. 
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Deal with Other Surprises
 

You may encounter a few other peculiarities when first using High 
Sierra that cause some initial surprise. 

Apple Mail 
If you’ve been using Apple Mail through a few macOS upgrades, you 
may not find this surprising, but if you’re new to the upgrade experi-
ence, a few aspects of Mail’s behavior are worth knowing about: 

•	 Importing Mail messages: In some cases (more likely when 
using Plan B than Plan A), the first time you launch Mail, a window 
informs you that it’s “upgrading” your mail database. This step 
should take no more than a few minutes, and is necessary because 
the High Sierra version of Mail has updated the database format it 
uses to store information about your messages. 

•	 Mail plug-ins: The first time you open Mail after upgrading, it 
moves most incompatible third-party plug-ins (which are normally 
stored in ~/Library/Mail/Bundles) into ~/Library/Mail/Bundles 
(Disabled) and displays an alert telling you what it’s disabled. Don’t 
try to reenable these manually; Mail will thwart your every effort to 
get them working. Check with the developer to see if a High Sierra-
compatible update is available. 

If Mail hangs or crashes on startup or if Activity Monitor (found 
in /Applications/Utilities) shows it to be using excessive CPU 
power, it could be due to an incompatible plug-in that Mail was 
unable to disable automatically. Force-quit Mail, look in ~/Library/ 
Mail/Bundles, and move anything you find there into ~/Library/ 
Mail/Bundles (Disabled). Then open Mail again. If it works, you can 
quit Mail, move a single plug-in back into ~/Library/Mail/Bundles, 
and test again. Repeat until only the problematic plug-in(s) are 
disabled, and then see if the developers have updated versions of 
them. 
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•	 Missing “On My Mac” messages: A number of people reported 
that when upgrading to Sierra, messages in Mail that were stored 
locally (that is, in “On My Mac” mailboxes) were missing. I never 
experienced this myself, and I don’t know if anyone will see this 
behavior in High Sierra. But if you do, you can restore those mes-
sages from a backup. If you don’t use Time Machine, then quit Mail 
and restore the entire ~/Library/Mail folder from a backup. If you 
do use Time Machine, open Mail, and then follow these steps: 

a.	 With Mail in the foreground, click the Time Machine icon in the 
Dock or choose Enter Time Machine from the Time Machine 
menu. Mail becomes the center of the Time Machine screen. 

b.	 Navigate to a mailbox you want to restore, or the location where 
that mailbox should be. 

c.	 Using the arrow buttons, or the navigation controls on the right 
side of the screen, browse your backups until you find one show-
ing the desired mailbox(es). 

d. Select one or more mailboxes and click Restore. 

Restored mailboxes are put directly in the On My Mac section of the 
Mail sidebar. 

First-run Alerts 
After upgrading to High Sierra, you may see an alert (Figure 11) the 
first time you open a previously installed third-party application that 
wasn’t downloaded from the App Store. 
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Figure 11: The first time you launch an application indirectly, High 
Sierra asks you to confirm that you really do want to open it. 

This alert doesn’t appear if you double-click the app icon, but only if 
you open it by an indirect method such as double-clicking one of its 
files. To confirm that you did intend to launch that app, click Open. 

System Extension Blocking 
If, after upgrading to High Sierra, you install a new third-party app 
that includes a kernel extension (or KEXT), a warning appears to tell 
you that the extension won’t run unless you give it permission to run 
(Figure 12). This is a security feature to prevent malware from gain-
ing low-level control of your Mac. (You can learn more about this new 
feature in Apple’s developer technical note Secure Kernel Extension 
Loading.) 

Figure 12: This alert appears when you try to install a new third-
party kernel extension in High Sierra (or when an app attempts to do 
so for you). 
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If you see this alert, click OK. To approve the new kernel extension, go 
to System Preferences > Security & Privacy > General, look for the 
notice at the bottom (Figure 13), and click Allow. (If you don’t do this 
within 30 minutes, the extension won’t be permitted to run, and the 
notice will disappear until the next time that extension tries to load— 
but those subsequent load attempts won’t re-trigger the warning dialog 
from Figure 12.) 

Figure 13: At the bottom of this preference pane, you can grant 
new kernel extensions permission to run. 

System Preferences Changes 
Apart from a few small cosmetic changes in System Preferences, the 
following new or modified preferences may be of interest: 

•	 iCloud: There’s a new Siri checkbox on the iCloud pane. When this 
is checked, macOS syncs Siri data among your Macs running High 
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Sierra and your iOS 11 devices; this enables Siri to use what it learns 
about you while using one of your devices on the others too. 

•	 Sharing—Content Caching: There’s a new category on the 
Sharing pane called Content Caching, which was previously avail-
able only in macOS Server. Contrary to what I said in earlier ver-
sions of this book, this feature does exactly what it appears to: when 
Content Caching is checked, your Mac becomes a distribution 
center for software updates and other content from Apple’s cloud 
servers, so you can reduce network usage by downloading stuff only 
once and letting other Macs and iOS devices on your network fetch 
the data from your Mac. There are also a few optional sub-features: 

‣	 Cache iCloud Content: Check this box to include photos and 
documents from your iCloud account in your cache. 

‣	 Share Internet Connection: This checkbox enables tethered 
caching, which is useful only for iOS devices that connect to your 
Mac with a USB cable. So it’s the sort of thing a school or other 
institution might use, but not something the average consumer 
will find helpful. 

‣	 Options: Click Options to set the maximum size of the cache on 
your Mac. Or, hold down Option to change the button’s name to 
Advanced Options, which provides you with a more extensive set 
of (fairly technical) prefere nces. 

Note: If you enable content caching, be sure to do so on only one
 

Mac on your network.
 

To learn more about content caching, read Apple’s articles About 
content caching and Set up content caching. 

•	 Sharing—File Sharing: A well-hidden new feature pulls in 
another capability that previously existed only in macOS Server: the 
option to use your Mac as a Time Machine server for other Macs on 
your network. To enable this feature, first check File Sharing. Next, 
click Options and make sure “Share files and folders using SMB” is 
selected. Then click the plus button under Shared Folders and 
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add a folder or volume where Time Machine backups for other 
computers will be stored. Now right-click (or Control-click) that 
folder in the list and choose Advanced Options from the contextual 
menu. Finally, check “Share as a Time Machine backup destina-
tion,” optionally fill in a size limit for Time Machine backups, and 
click OK. Once you’ve done this, other Macs on your network can 
choose this Mac as a destination in System Preferences > Time 
Machine > Select Disk. 

•	 Siri: The Siri preference pane has been rearranged and now sports 
some new options: 

‣	 Enable Ask Siri: This checkbox replaces “Enable Siri”; when it’s 
selected, you can control Siri with your voice, just as in Sierra. It 
was renamed because there’s now another way to communicate 
with Siri—see the second bullet under “Accessibility,” below. 

‣	 Siri Voice: Siri’s audio quality is greatly improved, and the 
intonation sounds much more natural. Note, however, that the 
Irish (Female) and South African (Female) voices are available 
only if you choose English (Ireland) or English (South Africa), 
respectively, from the Language pop-up menu. 

‣	 Siri Suggestions & Privacy: When you click this button, a dialog 
appears in which you can select or deselect individual apps Siri 
will consult to make suggestions. 

•	 Accessibility: There are two major changes on this pane: 

‣	 In the Zoom category, there’s a new “Speak items under the 
pointer” checkbox which tells macOS to identify items you hover 
over with the pointer, and an accompanying pop-up menu, from 
which you can choose “Always” or “Only when zoomed.” When 
the checkbox is selected, you can also adjust an “After delay” 
slider from Short to Long. 

‣	 In the new Siri category, you can select the “Enable Type to Siri” 
checkbox (whether or not “Enable Ask Siri” is selected in System 
Preferences > Siri), which lets Siri respond to typed commands. 
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Note: For the complete details on what’s new in High Sierra (as well 
as how to use many of the features that aren’t new), read Scholle 
McFarland’s Take Control of High Sierra. 

Final Software Advice
 

The best way to confirm that you have all your software installed and 
configured correctly is to try each application: 

1.	 Go through your /Applications folder (including the Utilities 
folder and anyplace else you’ve stored applications) and launch each 
app, one at a time. If an application uses plug-ins that you’re aware 
of, try to exercise at least one or two of them. When you’ve verified 
that the application works, quit it and move on to the next. Do the 
same with each of your third-party preference panes, by accessing 
them in System Preferences. (You needn’t do this all in one sitting— 
feel free to spread it out over several days or longer.) 

2.	 Make sure your important data displays correctly in the appropriate 
places, such as: contacts in Contacts, events in Calendars, stored 
email in Mail, photos and media in Photos and iTunes, and browser 
bookmarks in Safari. 

Similarly, if you use any third-party cloud storage services (such 
as Dropbox, OneDrive, or Google Drive), confirm that the relevant 
apps are running and that your data is in sync. 

3.	 If you use Unix software (including command-line tools and X11 
applications), check to see that it’s still present and functional. In 
particular, if you manually installed anything in /bin, /sbin, or /usr 
(except in /usr/local or /usr/share) in Yosemite or earlier, it will be 
gone—those are protected directories now, so you’ll have to reinstall 
those items in another location or restore them to a different direc-
tory from your backup. 
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Also, if you use one of the following package managers, you’ll want 
to update it and all the binaries you’ve installed using it: 

‣	 Fink: Update to the latest version. Try fink selfupdate first; if 
that doesn’t work, download a fresh copy. 

‣	 Homebrew: Use brew update to update Homebrew itself, and 
then brew upgrade to upgrade all your packages. 

‣	 MacPorts: Follow these migration instructions and install the 
latest version. 

After following these steps and using High Sierra for a few days, if you 
haven’t discovered any missing files or software that doesn’t work, you 
can conclude that High Sierra is working properly, and you can over-
write your just-before-upgrading bootable duplicate with a new version 
(remember, you turned off duplicates in Turn Off (Yes, Off) Automatic 
Duplicates?)—and turn automatic duplicates back on. 
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Troubleshoot 
Upgrade Problems 

Even if you diligently followed all the instructions in this book, you 
might encounter problems while upgrading. I can’t anticipate every 
difficulty you may have (or provide solutions in every case), but here 
are some of the most likely issues and how to deal with them. 

Can’t Run the High Sierra Installer… 

If the High Sierra installer icon has a slash through it, or if you try to 
run it and it quits immediately, the likely causes are: 

•	 You’re trying to run it on a Mac whose CPU is incompatible with 
High Sierra (see Model Support for full details). Solution: Buy a new 
Mac. (Sorry.) 

•	 The installer didn’t fully download, or the file was damaged. 
Solution: First delete the installer. Then open the App Store app, 
click Purchased, and download High Sierra again. 

Can’t Select Installation Volume…
 

If you run the High Sierra installer, click Show All Disks when asked to 
choose a destination, and find that the volume on which you want to 
install High Sierra isn’t available, chances are excellent that if you click 
the volume in question, the installer will tell you why it can’t be used— 
for example, not enough disk space, wrong partition map scheme, or 
wrong format—and, at the same time, tell you how to fix that problem. 

You may also see a message about an “unsupported partition 
structure,” which means the installer thinks the disk containing the 
volume where you want to put High Sierra isn’t partitioned in one of 
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the officially sanctioned ways. Repartitioning your disk as described in 
Prepare Your External Drive is the only reliable solution. 

Come to mention it, repartitioning is, in fact, the best (if brute-force) 
way to eliminate almost every possible cause of an unselectable 
volume. If all else fails, try that. 

Mac Won’t Start Up under High 
Sierra… 

Following installation—either on the first restart or a subsequent 
restart—if your machine will not start up under High Sierra (or if you 
experience a kernel panic upon the first restart), try these steps in 
order until you are able to start up normally: 

1.	 Disconnect non-essential USB devices: USB devices have 
been known to interfere with the Mac startup sequence, so if your 
Mac gets stuck on a gray screen and won’t finish booting, try this: 

a.	 Press and hold the power button for about 10 seconds until your 
Mac shuts down. 

b.	 Disconnect all USB cables from your Mac except any that go to a 
keyboard, mouse, or other pointing device. 

c.	 Press the power button again and wait for your Mac to start. If it 
starts normally, you can then reconnect your USB devices. If it’s 
still stuck after 10 minutes or so—or if it starts but then you 
experience a kernel panic—move on to the next step. 

2.	 Try a Safe Boot: Restart your Mac. (If the Mac is frozen or you see 
a kernel panic message, press and hold the power button for about 
10 seconds until the Mac shuts down. Then press the power button 
to turn it back on.) As soon as you hear the startup chime, press 
Shift. Release the key when the Apple logo appears on the screen. 
The Mac will complete the startup process, which may take consid-
erably longer than usual. You’ll eventually see the words “Safe Boot” 
on the screen—likely in red at the top of the login screen. 
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If High Sierra starts up normally after a Safe Boot, a third-party 
extension or startup item may be the culprit. Check in /System/ 
Library/Extensions, Library/StartupItems, /System/Library/ 
StartupItems, /Library/LaunchAgents, /Library/LaunchDaemons, and 
~/Library/LaunchAgents for third-party items that haven’t been 
updated recently (older items are more likely to have compatibility 
problems). This may include drivers for audio interfaces and input 
devices, security software, and certain system enhancements. 

If you find any that you explicitly recognize and suspect as a culprit, 
look for an uninstaller from the developer, and if there is one, use it. 
If not, consult the documentation that came with the software, or 
the developer’s website, for removal instructions. (I recommend 
against manually dragging these items to the Trash unless you can 
find no other way to remove them.) 

Restart and see if the problem is still gone. If so, reinstall the pro-
grams that use the deleted items one at a time, restarting after each 
one, until you find the culprit. 

If the problem does not go away after a Safe Boot, go to… 

3.	 Try macOS Recovery: Assuming the High Sierra installer 
succeeded in installing the Recovery HD volume (or that your Mac 
already had one from a previous installation of macOS), you can 
boot into macOS Recovery by choosing Apple  > Restart, clicking 
Restart, and immediately holding down Command-R until the 
Apple logo appears. A few moments later, you’ll see a macOS 
Utilities window; that tells you you’re using macOS Recovery (more 
about this in a moment). 

Note: If you can’t see the Apple  menu (because your Mac can’t 
even start up partway), hold down the power button for about 10 
seconds until your Mac shuts down. Then press it again and immedi-
ately hold down Command-R until the Apple logo appears. 

Once in macOS Recovery, select Disk Utility and click Continue. 
When it opens, click First Aid and follow the prompts to repair any 
problems that may have appeared on your High Sierra volume. 
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Choose Disk Utility > Quit Disk Utility to return to the macOS 
Utilities window. Then choose Apple  > Restart. 

4.	 Try another startup volume: If you need to run Disk Utility but 
macOS Recovery isn’t available, try: 

‣	 A bootable duplicate: The easiest option is to restart from your 
bootable duplicate (attach the drive, hold down the Option key 
when restarting, select the duplicate, and press Return), and 
then run Disk Utility. 

‣	 Apple-supplied boot media: Boot from a Snow Leopard Install 
DVD (if your Mac came with one). Then choose Utilities > Disk 
Utility. 

‣	 Target Disk Mode: If your Mac and another Mac you have access 
to (that can definitely start up correctly) both have FireWire or 
Thunderbolt ports, connect the two with a FireWire or Thund-
erbolt cable (or, if both Macs were made in 2012 or later, a USB 
cable). Restart the good Mac, holding down the T key to turn it 
into a fancy external drive. Then restart the misbehaving Mac, 
holding down the Option key, and select the good Mac’s startup 
disk. Once you’ve booted, run Disk Utility from the good Mac to 
try to fix the boot disk of the misbehaving Mac. 

5.	 Remove any nonessential hardware: Try restarting with only 
your Apple-supplied keyboard, mouse, and display attached, and 
without any third-party PCI or video cards. You may even need to 
remove extra RAM. If this works, check for driver updates, and then 
reattach the devices one at a time, restarting after each one. 

6.	 Reinstall High Sierra: If you still can’t start your Mac, consider 
reinstalling High Sierra. Perform a clean install (described in Up-
grade Using Plan B: Clean Install), omitting items in the Ap-
plications category when you work your way through the file trans-
fer portion of the installation to eliminate any possibility of software 
conflicts. (You can add those items later using Migration Assistant.) 

In most cases, these steps will lead to a happy High Sierra installation. 
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Finder Crashes or Hangs…
 

Your Mac is likely to be slow for a bit after its first boot into High 
Sierra, but if it’s unusable—as in, you get the Spinning Pinwheel of 
Doom for 15 minutes and you can’t open any apps—try restarting. (And 
if you can’t use the Apple  > Restart menu command, hold down the 
power button until your Mac turns off completely, and then press it 
again to turn it back on.) That has set things right for me on occasion. 
If that extra restart doesn’t help, however, you could be looking at a 
software conflict. 

Even if you diligently update all your software before installing High 
Sierra, you could run into a third-party app that has problems and yet 
isn’t disabled by Setup Assistant. One symptom to look for is the 
Finder repeatedly crashing—that is, your Finder windows and Desktop 
icons keep appearing and disappearing. Another is a Finder hang— 
even after several minutes, the Finder doesn’t respond to commands 
such as Finder > Empty Trash or File > New Finder Window. 

If you suspect that the Finder is crashing or hanging, open Console 
(in /Applications/Utilities), and watch the error messages as they flit 
by. If you see an app or filename repeatedly, that could be the source of 
the misbehavior. Try disabling it (if you know what and where it is), or 
follow the instructions in Mac Won’t Start Up under High Sierra…. 
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If All Else Fails…How to Downgrade 
As fantastic as High Sierra is, you might find it necessary to down-
grade to your old system at some point if: 

✦ An essential application does not work under High Sierra. 

✦ You encounter frequent crashes or compatibility problems. 

✦	 Drivers for your third-party hardware are not available, and replac-
ing that hardware is not an option. 

Reverting to an older system is never pleasant, but if you followed 
the instructions for backing up your old system, it’s not too bad. 

Assuming that, before upgrading to High Sierra, you created a 
bootable duplicate of your old system on another volume (discussed 
in Back Up Your Disk), follow these steps: 

1. If you downloaded or modified any data while working in High 
Sierra, be sure to save a copy of that data onto another volume 
before restoring your cloned system. 

2. Start up your Mac from a volume other than the one containing 
High Sierra. This can be your bootable duplicate itself, a startup 
DVD, a USB thumb drive, or any other volume with a valid Mac 
system. (Unfortunately, macOS Recovery won’t work in this in-
stance because you need to run third-party software.) 

3. Open Disk Utility and select the High Sierra volume. If the descrip-
tion says “APFS Volume,” follow the instructions in Configure a 
Drive in El Capitan or Later to erase it and format it as Mac OS 
Extended (Journaled). 

4. Launch your backup app (such as SuperDuper or Carbon Copy 
Cloner). Following the program’s instructions for making a 
bootable duplicate, choose the volume where the duplicate exists 
as the source. For the destination (or target), choose the volume 
containing High Sierra. 

5. Start the backup. 

6. When the backup finishes, choose the newly restored volume in 
the Startup Disk pane of System Preferences and restart. 

Your Mac should now be running your previous system again. 
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About This Book 
Thank you for purchasing this Take Control book. We hope you find it 
both useful and enjoyable to read. We welcome your comments. 

Ebook Extras
 

You can access extras related to this ebook on the web. Once you’re on 
the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy a 
subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

•	 Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

•	 Find out if we have any update plans for the ebook. 

If you bought this ebook from the Take Control website, it has been 
automatically added to your account, where you can download it in 
other formats and access any future updates. However, if you bought 
this ebook elsewhere, you can add it to your account manually: 

•	 If you already have a Take Control account, log in to your account, 
and then click the “access extras…” link above. 

•	 If you don’t have a Take Control account, first make one by follow-
ing the directions that appear when you click the “access extras…” 
link above. Then, once you are logged in to your new account, add 
your ebook by clicking the “access extras…” link a second time. 

Note: If you try these directions and find that your device is incom-
patible with the Take Control website, contact us.
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About the Publisher
 

alt concepts inc., publisher of Take Control Books, is operated by Joe 
Kissell and Morgen Jahnke, who acquired the ebook series from 
TidBITS Publishing Inc.’s owners, Adam and Tonya Engst, in May 
2017. Joe brings his decades of tech writing experience to his role as 
Publisher. Morgen’s professional background is in development work 

96 

https://www.takecontrolbooks.com/online-privacy?pt=INTERNAL
https://www.takecontrolbooks.com/dropbox?pt=INTERNAL
https://www.takecontrolbooks.com/dropbox?pt=INTERNAL
mailto:joe@takecontrolbooks.com?subject=Take%20Control%20of%20Upgrading%20to%20High%20Sierra
https://joeontech.net/
https://en.wikipedia.org/wiki/Large_Hadron_Collider
http://joekissell.us2.list-manage.com/subscribe?u=0c38d715348b092c59d6a1b7f&id=bf174844e3
https://twitter.com/joekissell
https://joekissell.com/
https://twitter.com/joekissell
https://twitter.com/joekissell
https://twitter.com/spectatrix


           
  

  

  

     

       

for nonprofit organizations, and she employs those skills as Director of 
Marketing and Publicity. 

Credits 
• Publisher: Joe Kissell 

• Editor: Tonya Engst 

• Cover design: Sam Schick of Neversink 

• Logo design: Geoff Allen of FUN is OK 

97 

https://madebyneversink.com
http://www.funisok.com/


      
 

        

           

            
              

            
          

            
                  
                  
                
                

                 
    

              
                

       

             
               
               

                  
          

                 
          

           
             

                
                

               
        

              
                

                
               

Copyright and Fine Print 
Take Control of Upgrading to High Sierra 
ISBN: 978-1-947282-07-0
 
Copyright © 2017, alt concepts inc. All rights reserved.
 

alt concepts inc. 4142 Adams Ave. #103-619, San Diego CA 92116, USA 

Why Take Control? We designed Take Control electronic books to help readers regain 
a measure of control in an oftentimes out-of-control universe. With Take Control, we also 
work to streamline the publication process so that information about quickly changing 
technical topics can be published while it’s still relevant and accurate. 

Our books are DRM-free: This ebook doesn’t use digital rights management in any 
way because DRM makes life harder for everyone. So we ask a favor of our readers. If you 
want to share your copy of this ebook with a friend, please do so as you would a physical 
book, meaning that if your friend uses it regularly, they should buy a copy. Your support 
makes it possible for future Take Control ebooks to hit the internet long before you’d find 
the same information in a printed book. Plus, if you buy the ebook, you’re entitled to any 
free updates that become available. 

Remember the trees! You have our permission to make a single print copy of this 
ebook for personal use, if you must. Please reference this page if a print service refuses 
to print the ebook for copyright reasons. 

Caveat lector: Although the author and alt concepts inc. have made a reasonable effort 
to ensure the accuracy of the information herein, they assume no responsibility for errors 
or omissions. The information in this book is distributed “As Is,” without warranty of any 
kind. Neither alt concepts inc. nor the author shall be liable to any person or entity for any 
special, indirect, incidental, or consequential damages, including without limitation lost 
revenues or lost profits, that may result (or that are alleged to result) from the use of these 
materials. In other words, use this information at your own risk. 

It’s just a name: Many of the designations in this ebook used to distinguish products 
and services are claimed as trademarks or service marks. Any trademarks, service marks, 
product names, or named features that appear in this title are assumed to be the property 
of their respective owners. All product names and services are used in an editorial fashion 
only, with no intention of infringement. No such use, or the use of any trade name, is 
meant to convey endorsement or other affiliation with this title. 

We aren’t Apple: This title is an independent publication and has not been authorized, 
sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses 
terms that are registered trademarks or service marks of Apple Inc. If you’re into that sort 
of thing, you can view a complete list of Apple Inc.’s registered trademarks and service 
marks. 
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Also by Joe Kissell 
Click any book title below or visit our web catalog to add more ebooks 
to your Take Control collection! 

Are Your Bits Flipped?: Overcome common tech misconceptions with 
this collection of easy-to-read essays. 

Take Control of 1Password: Slowed down by entering passwords 
repeatedly? Learn how to let 1Password do the heavy lifting. 

Take Control of Apple Mail: Learn the ins and outs of Apple’s email 
app on macOS and iOS. (A new High Sierra/iOS 11 edition is coming 
soon—if you buy the current edition, you’ll get a free upgrade.) 

Take Control of Dropbox: Discover the many features—especially the 
non-obvious ones!—that make Dropbox so useful and popular. 

Take Control of iCloud: Understand the many features, get set up 
properly, and enjoy iCloud! 

Take Control of the Cloud: Wrap your head around the wide variety of 
cloud services and apps, and make smart purchasing decisions. 

Take Control of the Mac Command Line with Terminal: Master your 
Mac’s command-line interface and learn basic Unix skills. 

Take Control of Your Digital Legacy: Make sure your important 
digital information is preserved for future generations. 

Take Control of Your Online Privacy: Learn what’s private online (not 
much)—and what to do about it. 

Take Control of Your Paperless Office: With your Mac, scanner, and 
this ebook in hand, you’ll finally clear the chaos of an office overflow-
ing with paper. 

Take Control of Your Passwords: Overcome password overload 
without losing your cool—and view the comic that goes with this 
ebook! 
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